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1	 Overview

1.1	 Introduction

Your StudioLive™ AI mixer comes with a powerful software library that 
includes Capture™ 2 and Studio One® Artist. In addition, PreSonus Virtual 
StudioLive AI (VSL-AI) editor/librarian/remote-control software with Smaart 
Measurement Technology™ for Mac and Windows is a free download from the 
PreSonus Web site. PreSonus also offers StudioLive Remote-AI (SL Remote-AI) 
remote-control software for iPad® and QMix™-AI aux-mix control software for 
iPhone®/iPod touch®; both are free downloads from the Apple App Store.

Whether you want to remote-control your StudioLive from an iPad, provide your 
musicians with the ability to control their own monitor mixes, record a live show 
with just one mouse click, analyze your sound system’s performance in a room and 
adjust to compensate, mix your next hit album, or any combination of the above, 
your StudioLive and its software provide you with a complete suite of tools.

We encourage you to contact us with questions or comments regarding 
this product. PreSonus Audio Electronics is committed to constant 
product improvement, and we value your suggestions highly. We believe 
the best way to achieve our goal of constant product improvement is by 
listening to the real experts: our valued customers. We appreciate the 
support you have shown us through the purchase of this product.

1.2	 About This Manual

We suggest that you use this manual to familiarize yourself with the features, 
applications, and correct connection procedures for your StudioLive AI Software 
Library before trying to connect your StudioLive to your computer, iPad, iPhone, 
or iPod touch. This will help you avoid problems during installation and setup.
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Throughout this manual you will find Power User Tips. These tips provide 
useful hints on how to best use the StudioLive AI Software Library and 
take advantage of unique workflow functions and features.

1.3	 Technical Support

Many technical issues can arise when using a standard computer as a digital 
audio workstation (DAW) and when networking wireless devices. PreSonus can 
only provide support for issues that directly relate to the StudioLive AI mixer 
and interface, Universal Control-AI control-panel software, Virtual StudioLive-
AI mixer-control software, StudioLive Remote-AI, QMix-AI, and Studio One.

PreSonus does not provide support for computer hardware, iOS hardware, wireless 
networks, operating systems, and non-PreSonus hardware and software, and it may 
be necessary to contact the manufacturer of these products for technical support.

Please check our Web site (www.presonus.com) regularly for 
software information and updates, firmware updates, and 
support documentation for frequently asked questions.

Online technical support is available to registered users through 
their My PreSonus account. Visit my.presonus.com to register.

PreSonus telephone technical support is available to customers in the USA on 
Monday through Friday from 9 a.m. to 5 p.m. Central Time by calling 1-225-
216-7887. Customers outside of the USA should contact their national or 
regional distributor for telephone technical support. A list of international 
distributors is provided at www.presonus.com/buy/international_distributors.

Advanced troubleshooting guides can be found at support.presonus.com/forums.

1.4	 Summary StudioLive AI Software Library Features

1.4.1	 Virtual StudioLive-AI

The Virtual StudioLive-AI (VSL-AI) application is completely integrated 
with StudioLive AI mixers. VSL-AI is a highly advanced editor/librarian and 
control panel. Because of the continuous bidirectional communication 
between your StudioLive and VSL-AI, whatever you do on the StudioLive‘s 
control surface will be reflected in VSL-AI and vice versa.

•• Easy drag-and-drop workflow

•• Drag presets directly to channels

•• Drag parts of presets directly to components in the Fat Channel

•• Adjust the Fat Channel dynamics processing and 
parametric EQ, the graphic EQ, and the effects

•• Quickly drop entire scenes to the mixer for instant recall 
of all channel, effects, and graphic EQ settings

•• Swipe the mouse to quickly mute, solo, assign channels to multiple buses, etc.

•• Time-stamped backups of the entire board

•• Smaart Spectra™ Time-Frequency Spectrograph on every channel and bus

•• Smaart Spectra™ Real-Time Analyzer on every channel and bus

•• Smaart Room Analysis Wizard: generates a frequency-response trace of your room

•• Smaart System Delay Wizard: automatically calculates and 
sets the correct delay time on subgroup outputs

•• Smaart Output Check: quickly verify that StudioLive 
outputs are connected and functioning correctly

•• Talkback On/Off

•• Talkback Assign

•• Preset Management:
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•• Store and organize presets on your computer, then 
transfer them to your mixer for use at the gig

•• Create presets on the road, store them to the mixer, then drag them to 
your preset pool the next time you’re connected to the computer

•• Reorder presets in mixer memory; easily order 
presets to best fit your gigs and workflow

•• Mixer Overview

•• See all of the most-used parameters on the mixer at once

•• See the state of all Fat Channel settings at once

•• See all aux mixes at once

•• See the current effects and parameter settings

•• See graphic equalizer settings

1.4.2	 StudioLive Remote-AI for Apple iPad®

StudioLive Remote-AI (SL Remote-AI) for iPad provides direct wireless control 
over StudioLive AI mixers. As long as your StudioLive and your iPad are on 
the same wireless network, SL Remote-AI can control the console.

•• Provides wireless control over the StudioLive AI-series digital mixers

•• Overview page displays levels, mutes, panning, EQ curves, and 
Fat Channel processing for multiple channels at once

•• Aux page shows the levels, panning, and Fat Channel 
processing for the aux sends and internal FX buses

•• GEQ page lets you adjust the Main GEQ

•• Channel Zoom page shows every parameter for a single channel

•• Control any StudioLive AI mixer on the wireless network from one iPad

•• Multiple iPads can control the same StudioLive

•• Set permissions on the StudioLive AI mixer so that StudioLive Remote-
AI on any iPad on the network controls only specified functions

•• Talkback On/Off

•• Talkback Assignments

•• Remote-Control Smaart Systems Wizards

•• Remotely recall scenes stored on your StudioLive AI mixer

•• Available free from the Apple App Store

1.4.3	 QMix-AI for iPhone® and iPod touch®

QMix-AI for iPhone and iPod touch provides performers with wireless control 
over their monitor (aux) mixes onstage and in the recording studio.

•• Provides wireless control over StudioLive AI-series digital mixers

•• Remote-control aux mixes on any StudioLive on the same network

•• Using the Wheel of Me, control the levels of all of the user’s 
channels simultaneously, with one simple control.

•• Set permissions on your StudioLive AI mixer so that QMix-AI on 
any iPhone on the network only controls a specified aux mix

•• Available free from the Apple App Store
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1.4.4	 Capture 2 

Included with StudioLive is Capture 2, a digital-audio multitrack-recording application 
designed to make recording quick and easy. Perfect for live recording and for mixing 
your audio in real time to a stereo audio file, Capture 2 was designed to interface 
perfectly with StudioLive-series mixers, allowing instant setup and recording.

Capture 2 allows you to record a single stereo track from the StudioLive’s main 
output, one pair of subgroup outputs, or a pair of aux sends, in addition to all input 
channels. This enables you to record the main mix or create a separate recording mix.

•• Multitrack recording application (input channels 
plus stereo stream from StudioLive)

•• NEW! One-click recording with Record Now button
•• NEW! Prerecord captures audio up to a minute before you press Record
•• NEW! Auto-Save at user-definable intervals
•• NEW! Automatic session and file recovery if the power fails
•• NEW! Sessions store metadata, enabling automatic session naming
•• NEW! Virtual Soundcheck mode makes it simple to 

soundcheck using previously recorded material
•• NEW! Session Lock feature prevents accidental keyboard access
•• Essential editing suite (copy, cut, paste, splice, resize)
•• NEW! Big Meter mode turns your monitor into a gigantic meter bridge
•• NEW! Stereo Playback mode—use Capture with any computer sound card
•• Peak LED-style meter bridge with clip indicators
•• Marker placement and recall
•• NEW! Marker List with Quick Locate
•• Export between markers
•• Record stereo mix from StudioLive AI mixer
•• Full transport control
•• Import/export individual WAV, AIFF, or OpenTL
•• Compatible with Mac® and Windows®

1.4.5	 Studio One Artist

All PreSonus audio interfaces include PreSonus Studio One Artist recording 
software, which comes with over 6 GB of plug-ins, loops, and samples, giving 
you everything you need for music recording and production. The Studio 
One Artist Quick Start Guide is located in Section 8 of this manual. You will 
find a complete user manual on the Studio One Artist installation DVD.

•• Unlimited track count, inserts, sends, and plug-in instantiations

•• 20 high-quality PreSonus Native Effects™ plug-ins, in eight categories: 
amp modeling (Ampire XT), delay (Analog Delay, Beat Delay), distortion 
(RedLight Dist™), dynamics processing (Channel Strip, Compressor, Gate, 
Expander, Limiter, Tricomp™), equalizer (Channel Strip, Pro EQ), modulation 
(Autofilter, Chorus, Flange, Phaser, X-Trem), reverb (Mixverb™, Room Reverb), 
and utility (Binaural Pan, Mixtool, Phase Meter, Spectrum Meter, Tuner)

•• Four high-quality PreSonus virtual instruments, including: Presence™ 
sample player, Impact™ drum machine, SampleOne™ sampler, 
and Mojito analog-modeled subtractive synthesizer

•• Over 6 GB of loops, samples, and instruments

•• Open Capture 2 files natively

•• Innovative and intuitive MIDI mapping

•• Powerful drag-and-drop functionality for faster workflow

•• Mac OS X® and Windows® compatible
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2	 Connecting to a Computer
The Universal Control-AI installer includes the ASIO/WDM (Windows) and Core 
Audio (OS X) drivers for the StudioLive AI-series mixers, as well as Universal 
Control-AI, and Virtual StudioLive-AI. We made the Universal Control-AI installer 
as simple and easy to follow as possible, and it will take you through each step 
of the installation process. Please read each message carefully to ensure the 
StudioLive driver and Universal Control-AI with VSL-AI are properly installed. In 
particular, be careful not to connect your StudioLive to the computer too soon.

Please visit www.presonus.com for the latest system requirements 
and an updated list of compatible hardware. It is also recommend 
that you check your recording software’s system requirements.

Power User Tip: As part of our commitment to the quality of our products, 
PreSonus continually updates its product drivers and software. Because of 
this, it is wise to visit www.presonus.com and check for the latest driver build 
before installing your product. Note: The speed of your processor, amount of 
RAM, and capacity, size, and speed of your hard drives will greatly affect the 
overall performance of your recording system. A faster processor and more 
RAM can reduce signal latency (delay) and improve overall performance.

2.1	 Installation for Windows

Before beginning the Universal Control-AI installation setup, 
please quit all applications, including antivirus software, and 
disconnect the StudioLive from your computer.

Follow the onscreen instructions to complete the installation. When the 
installer has finished, it will prompt you to reboot your computer. 
 
 
 
 
 
 

Click “Finish” to automatically restart your PC. Once your computer has 
rebooted, connect the StudioLive. When the Found New Hardware wizard 
launches, follow the “Recommended” steps. 
 
 
 
 
 

Your StudioLive is now synced to your computer and ready to use!
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2.2	 Installation for Mac OS X

The Universal Control-AI Installer will take you through each step of 
the installation process. Please read each message carefully, and be 
especially careful that you do not connect your StudioLive too soon.

1.	 After launching the installer, you will be directed to the Welcome screen. 
Click “Continue” and follow the onscreen instructions. 
 
 
 
 
 

2.	 You will be directed to choose the hard drive onto which you want to install 
the StudioLive driver and Universal Control-AI with VSL-AI. You must choose 
your system drive. Storage drives and partitions cannot be used as hosts for 
the driver. 
 
 
 

3.	 When the installation is completed, you will be prompted to reboot your 
computer. After your Mac has restarted, connect your StudioLive with a 
FireWire cable and power it on. 
 
 
 
 

4.	 Once the installation is completed, you will find the 
Universal Control-AI program in your Applications folder. 
It is recommended that you place this in your Dock.

You are now ready to use your StudioLive!

2.3	 Using the StudioLive as an Audio Interface

The StudioLive AI mixers feature a built-in FireWire 800 interface that 
can be used with any application that supports Core Audio or ASIO 
and can also be used as a WDM device for a Windows computer.

Any input and bus with a Select button, plus the Solo bus, tape input, and 
talkback mic, can be recorded. Please consult the documentation that came 
with your audio application for specific instructions on how to select the 
StudioLive driver as the audio device driver for your software. It is important 
to note that the StudioLive AI mixers use the same driver as the PreSonus 
FireStudio family of interfaces and StudioLive 24.4.2 and 16.4.2 mixers. Its 
driver is displayed as “PreSonus FireStudio” in all driver-selection menus.

Power User Tip: If your StudioLive will not connect to the computer, verify 
that the FireWire cable is properly connected to the StudioLive and to your 
computer and disconnect all unnecessary peripheral FireWire devices.
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2.4	 Using the StudioLive with Popular Audio Applications

Below are basic driver-setup instructions for several popular audio 
applications. Complete setup instructions for PreSonus Studio One Artist 
and a brief tutorial on its features are located in Section 8 of this manual.

Steinberg Cubase 4+

1.	 Launch Cubase.

2.	 Go to Devices | Device Setup.

3.	 Select “VST Audio System” from the Devices column in the Device Setup.

4.	 Select PreSonus FireStudio from the ASIO Driver dropdown list.

5.	 Click “Switch” to begin using the StudioLive Driver.

6.	 Once you have successfully changed the driver, go to Devices | 
VST Connections to enable your input and output buses.

Ableton Live 5+

1.	 Launch Ableton Live.

2.	 Go to Options | Preferences | Audio.

3.	 Choose Driver Type: ASIO | Audio Device: ASIO PreSonus FireStudio

4.	 Go to Input Config : Enable and select the desired Input channels.

5.	 Go to Output Config : Enable and select the desired Output channels.

6.	 You may now select the StudioLive’s inputs and 
outputs for each track created in Live.

Apple Logic Pro/Express 7+:

1.	 Launch Logic Pro/Express.

2.	 Go to Logic | Preferences | Audio.

3.	 Click on the Devices Tab.

4.	 On the Core Audio tab, check Enabled.

5.	 Select PreSonus FireStudio from the device menu.

6.	 You will be asked if you’d like to relaunch Logic. Click “try (re)launch.”

7.	 Your StudioLive features custom I/O labels for faster work flow. To enable 
these labels for use in Logic, go to Options | Audio | I/O Labels.

8.	 The second column in the pop-up window will be named 
“Provided by Driver.” Activate each of these labels for your 
StudioLive. When you are done, close this window.

9.	 You are now ready to use your StudioLive.
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Avid Pro Tools 9+

1.	 Launch Pro Tools.

2.	 Got to Setup | Hardware and select PreSonus FireStudio 
from the Peripherals list. Click OK.

3.	 Go to Setup | Playback Engine and select PreSonus FireStudio 
from the menu at the top of the window. Click OK.

Cakewalk Sonar 6+

1.	 Launch Sonar.

2.	 Go to Options | Audio... and click on the Advanced tab.

3.	 Change the Driver Mode to “ASIO.”

4.	 Click the “OK” button.

5.	 Restart Sonar.

6.	 Go to Options | Audio... and click on the Drivers tab.

7.	 Highlight all input and output drivers beginning with “PreSonus FireStudio.”

8.	 Go to Options | Audio... and click on the General tab.

9.	 Set the Playback Timing Master to “PreSonus FireStudio ... DAW Out 1.”

10.	Set the Recording Timing Master to “PreSonus FireStudio ... Mic/Inst 1.”

2.5	 Digital Sends and Returns

When using the StudioLive as an audio interface, it is important to understand 
the terms “digital send” and “digital return.” Because the audio interface 
in the StudioLive is completely integrated with the other functions of 
the mixer, the FireWire I/O is designed to work as an independent bus. 
You can route (send) signals from other buses to the FireWire bus, and its 
output (return) signal is hard-coded to designated mixer channels.

The StudioLive 32.4.2AI has 48 available sends and 34 returns.

The StudioLive 24.4.2AI has 40 available sends and 26 returns.

The StudioLive 16.4.2AI has 32 available sends and 18 returns.

2.5.1	 Channel Digital Sends

Digital Sends 1 through 32/24/16 are hard-coded to be sent pre-fader from 
the 32/24/16 input channels of the StudioLive. These sends are pre- or post-Fat 
Channel EQ and dynamics depending on the channel or bus being recorded.

The Digital Output button in the Fat Channel indicates the signal flow for the selected 
channel or bus send to the digital bus. Input channels are sent pre-Fat Channel; while 
the subgroup, main, and aux buses are sent post-Fat Channel EQ and Dynamics to 
the digital bus. 
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2.5.2	 Auxiliary Digital Sends 

Each StudioLive AI mixer features additional Digital Sends that can be 
routed in stereo pairs from the Setup tab in VSL-AI. Any combination of 
eight of the following stereo inputs and buses can be selected:

•• Main Mix Left / Right

•• Subgroup 1 and 2

•• Subgroup 3 and 4

•• Aux Send 1 and 2

•• Aux Send 3 and 4

•• Aux Send 5 and 6

•• Aux Send 7 and 8 (StudioLive 24.4.2AI and 32.4.2AI only)

•• Aux Send 9 and 10 (StudioLive 24.4.2AI and 32.4.2AI only)

•• Aux Send 11 and 12 (StudioLive 32.4.2AI only)

•• Aux Send 13 and 14 (StudioLive 32.4.2AI only)

•• Aux Send A and B (FXA and FXB Send Mixes)

•• Aux Send C and D (FXC and FXD Send Mixes)

•• Aux Return A (Aux Input A)

•• Aux Return B (Aux Input B)

•• 2 Track Left/Right

•• Talkback Left/Right

•• Solo Left/Right

Power User Tip: Note that either channel of the stereo pair can still be accessed 
on a mono track in your host application; only the routing must be assigned as a 
stereo pair. For instance, if you have a backing-vocal group routed to Subgroup 
1 and a guitar group routed to Subgroup 2, you would create two mono tracks 
in your recording application. The track whose input is assigned to Subgroup 
1 will record the backing-vocal group, and the track whose input is assigned 
to Subgroup 2 will record the guitar group. If, however, you have a stereo drum 
group assigned to Subgroups 3-4, you can create a stereo track in your recording 
application and assign its input to Subgroups 3 and 4. For more information on 
subgroup mixing, please see Section 4.5 in the StudioLive AI Owner’s Manual.

The obvious exception to this principle is the Talkback Mic input. In this instance, the 
same signal will be printed on both sides of the send. In your recording software, you can 
create a mono track and assign it to either side of the stereo Digital Send to which it is 
routed. Both Digital Sends receive the same mono signal from the talkback mic preamp.

Section 4.8.1 discusses how to select the sources for 
these auxiliary stereo Digital Sends.
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2.5.3	 Digital Returns

Each StudioLive input is hard-coded to receive its respective digital return. Outputs 1 
through 32/24/16 in your recording application route these playback streams to their 
respective channels on the StudioLive (that is, the software’s Output 1 always goes to 
StudioLive Channel 1 digital return and so on). Once you route a track in your 
recording application to play through one of these outputs, it will always be 
accessible on its channel by simply pressing the Digital Return button.

Power User Tip: It is important to think of your digital returns and your analog inputs in 
the same way. When a digital return is engaged, it replaces the analog input in the mix. 
You can process it in the Fat Channel, include in it Aux mixes, and send it to an FX mix.

2.5.4	 Main Digital Return

To provide the most flexible mixing environment, PreSonus has provided a stereo 
Main Digital Return to free the first 32/24/16 returns to be patched directly to their 
corresponding channels on your StudioLive AI mixer. Digital Returns 33-34/25-26/17-
18 are hard-coded to the Digital Return buttons in the 2Track In and Monitor sections 
on your StudioLive AI mixer. In this way, you can monitor the main output from your 
recording application without using two channels on your StudioLive, leaving the 
other channels available to be routed to the Fat Channel or for inserting a plug-in on 
a live instrument.

2.6	 Using Plug-In Effects as Inserts

Digital Transport streaming on your StudioLive is continuously bidirectional. This 
means that the StudioLive is always sending signals from the direct Digital Sends 
on all input channels, as well as from the auxiliary inputs and buses assigned to 
the second bank of Digital Sends. At the same time, the StudioLive is receiving 
signals back from the digital returns. Because the digital returns always come 
back to their respective StudioLive channels, you can quickly insert a plug-in from 
your recording application into any channel strip and monitor it in real time.

In this example, we will insert the Beat Delay plug-in from 
PreSonus Studio One onto Channel 4 of the StudioLive.

1.	 To begin, create a mono audio track in Studio One. 
 
 
 
 
 
 
 
 

2.	 Assign its input to Channel 4 and its output to Output 4.

(Several DAW applications, including Apple Logic, do not offer mono 
output buses. If this is the case, you must route the output stream to, for 
example, Channels 3-4 and pan the channel all the way to the right so 
that it will only be sent to Output 4. Please consult your software’s user 
manual for specific instructions.) 
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3.	 Once you have the routing set up in Studio One, drag-and-drop the Beat 
Delay plug-in onto your track and record-enable it. Software monitoring 
will be enabled automatically. 
 
 
 
 
 
 
 
 

4.	 Press the Digital Return button on Channel 4 of your StudioLive. You can 
now monitor the analog signal from Channel 4 on your StudioLive with 
your inserted effect (in this case, Beat Delay).

Power User Tip: When using plug-ins as inserts, it is very important 
that you set as low a buffer size on your computer as possible without 
creating performance issues. For most new computers, this won’t be an 
issue. A buffer size of 128 or less will provide low enough latency for most 
plug-in types; however, dynamics and EQ plug-ins and performance 
plug-ins such as amp-modelers may require lower latency settings. 
See Section 4.1 for more information on buffer size settings.

Please note: setting the buffer size too low on older or slower computers, 
or on a computer that has not been properly optimized, may result 
in poor performance. Always be sure to test the limits of your system 
before attempting CPU-intensive tasks in mission-critical situations.
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3	 Networking Your StudioLive AI mixer
Your StudioLive AI-series mixer provides you with two choices of connecting 
to a wireless router. You can either connect it directly to the router using an 
Ethernet cable, or connect it wirelessly using the included USB Wi-Fi adapter. 
It is important to mention that the StudioLive AI mixer does not support hot-
swapping the Wi-Fi adapter. It must be connected when you boot up your 
mixer to use it. Also, the included adapter is the only LAN adapter supported for 
use with the StudioLive AI mixer. If a direct Ethernet connection to a network 
connection is available, the Wi-Fi adapter will not scan for additional networks.

Power User Tip: Network connections occasionally require troubleshooting, especially 
when a lot of wireless networks are in use. Because of this, it is always a good idea 
to get your networked devices and StudioLive happily communicating before the 
pressure is on, and you have a singer trying to dial in a monitor mix while you’re 
trying to mic the drum kit. So while the guitarist is flirting with the bartender, take 
a quick moment to get your iPad, iPhone, computer, and StudioLive talking.

3.1	 Step 1: Connect your StudioLive to your Network

1.	 Press the System button on your StudioLive to open the System menu. 
 
 
 
 
 
 
 

2.	 Page down to Page 2: Network. 
 
 
 
 
 

3.	 Press the Recall button to scan for available networks. 
 
 
 
 
 
 
 
 

If your wireless router is connected to your StudioLive 
mixer’s Ethernet port, your mixer will join automatically. 
Once you see an IP number appear on the LCD, your mixer is 
ready to be wirelessly remote controlled by VSL-AI, SL 
Remote-AI, or QMix-AI. Continue to Step 4 for instructions 
on connecting wirelessly to your router. 
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4.	 Use the Value Encoder to scroll through the available networks. 
 
 
 
 
 
 
 

5.	 When you have found the network you would like to use,  
press the Store button to join.

Power User Tip: Your StudioLive AI mixer ships from the factory ready to connect to any 
wireless network named “StudioLive” with a password of “StudioLive”. If you configure you 
wireless router with this information, your StudioLive mixer will connect as soon as you 
press Store. 
 
 
 

6.	 Use the Value encoder and Next button to enter the password for your network. 
When you are done, press the Store button to connect to the network. Every time 
you turn on your StudioLive AI mixer, it will look for this network and attempt to 
connect to it.

Please Note: the StudioLive only supports WPA and WPA2 security.If you do not see an IP 
address appear within 10 seconds after pressing the Store button, verify that your router is 
configured using one of these security protocols. 
 
 

7.	 Once your mixer has successfully joined to your wireless 
network, you will see an IP Number appear on the LCD and 
your mixer is ready to be wirelessly remote controlled by 
VSL-AI, SL Remote-AI, or QMix-AI. 
 

3.2	 Step 2: Connect your Computer to your Network

Windows 7+

1.	 Click on the network icon in the notification area to 
open the Connect to Network Control Panel.

2.	 Select the same wireless network that you saved on your StudioLive AI mixer.

3.	 Enter the password.

4.	 Click Connect.

Mac OS X 10.7 and later

1.	 On the Menu bar click on the Wireless Status icon.

2.	 From the pull-down menu select the same wireless network 
that you saved on your StudioLive AI mixer.

3.	 Enter the password.

4.	 Click Join.
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3.3	 Step 3: Connect your iPad to your Network

1.	 Tap on the Settings icon in your iPad. 
 
 
 

2.	 Tap on “General.” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.	 Tap on “Network.”

4.	 Tap on “Wi-Fi.”
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5.	 Under “Choose a Network,” find the same network you saved 
on your StudioLive from the list. Tap the network to select it. 
 
 
 
 
 
 
 

6.	 Enter the password when prompted and tap Join.

7.	 Tap on the menu arrow to the right of the desired network’s 
name to open its network settings. 
 
 

8.	 Turn Auto-Join to “On.” You are now ready to launch 
StudioLive Remote-AI and mix on the go! 
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3.4	 Step 4: Connect your iPhone/iPod touch to your Network

1.	 Tap on the Settings icon in your iPhone/iPod touch. 
 
 
 

2.	 Tap on “Wi-Fi” making sure it is set to “On.” 
 
 
 
 
 
 
 
 
 

3.	 Under “Choose a Network,” select the same network you 
saved on your StudioLive from the list. 
 
 
 
 
 
 
 

4.	 Tap on the network to select it.

5.	 Enter the password when prompted and tap Join.

Important: You must connect your computer and iOS devices to the 
same network as your StudioLive AI mixer each time you plan on 
remote-controlling your StudioLive with StudioLive Remote-AI, VSL-AI, 
or QMix-AI. 
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3.5	 Step 5: Setting iOS Permissions

Controlling your StudioLive remotely with StudioLive Remote-AI for iPad or 
QMix-AI for iPhone/iPod touch allows you to move about the venue freely. 
However, it can also put the full power of the StudioLive in multiple hands—
some more adept than others. Therefore, your StudioLive enables you to limit 
each iOS device’s access to the mixer features by setting permissions.

Once an iOS device is connected to your wireless network and has launched 
SL Remote-AI or QMix-AI, the device will be displayed in the Remote Devices 
list on the System Menu on your StudioLive. Each device will be listed using its 
device name so you can easily identify which device is which. This name can 
be changed in iTunes or in the General>About settings on the iOS device.

Once you have connected and configured an iOS device, the same permissions 
will be set for that device every time you connect it. Complete information 
about SL Remote-AI and QMix-AI can be found in Sections 5 and 6.

Note: You must give permission to an iOS device from the StudioLive System menu 
in order to remote control your StudioLive AI-series mixer from that device.

1.	 Press the System button on your StudioLive to launch the System menu. 
 
 
 
 
 
 
 
 

2.	 Page down to navigate to Page 3: iOS Setup. 
 
 
 
 
 

3.	 Use the Value encoder to scroll through the list of available iOS devices. 
 
 
 
 
 
 
 

4.	 When you find the device for which you’d like set permissions, use the Next button 
to navigate to the first permissions field. Use the Value encoder to set the device 
permission. 
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3.5.1	 StudioLive Remote for iPad Permissions

When setting permissions for SL Remote-AI users, you will choose between 
giving full access to all SL Remote-AI functions or providing limited access 
to just a few aux-mix functions. In most cases, one iPad will be configured 
as front-of-house (FOH), and the others will be configured as aux mixes.

Mix Permissions. Sets the level of functionality in SL Remote-AI.

•• None. SL Remote-AI on the select iPad will not be able 
to control your StudioLive AI-series mixer

•• FOH. Enables all SL Remote-AI functions.

•• All Auxes. SL Remote-AI will only control the channel send levels for all aux mixes. 

•• Aux 1-14/10/6. SL Remote-AI will only control the 
channel send levels for the specified aux mix.

Other Permissions. Choose between Ch Rename or None. Ch Rename 
allows SL Remote-AI users to remotely change the channel and bus 
scribble-strip labels. These changes are also reflected in VSL-AI, QMix-
AI, and on the Channel Info page on the StudioLive AI mixer.

3.5.2	 QMix-AI for iPhone/iPod Touch Permissions

When setting permissions for QMix-AI users, you will choose between 
providing full access to all aux mixes, providing access to only a single 
aux mix, and limiting the user to just the Wheel of Me functions.

Mix Permissions. Sets the level of functionality in QMix-AI.

•• None. QMix-AI on the select iPad will not be able 
to control your StudioLive AI mixer.

•• All Auxes. QMix-AI will control the channel send levels for all aux mixes. 

•• Aux 1-14/10/6. QMix-AI will only control the channel 
send levels for the specified aux mix.

Other Permissions. Choose between Wheel Only or None. Wheel Only disables 
the Aux Mix page in QMix-AI. When this is enabled, the user will only be able 
to use the Wheel of Me on the single aux to which you’ve provided access. 
When Wheel Only is enabled, you can only give access to one aux mix.
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4	 Universal Control-AI and VSL-AI
Universal Control-AI includes two windows: the Launcher window and 
the Device window. For the StudioLive, the Device window is the Virtual 
StudioLive-AI (VSL-AI) application. VSL-AI provides bidirectional control of 
channel, subgroup, aux, and main-bus levels; Fat Channel parameters; aux 
mixes; effects; and the graphic EQs. It also provides a visual overview of your 
StudioLive settings so that you can see, adjust, and organize them. VSL-AI 
includes a librarian, allowing you to easily manage your presets and scenes.

Controlling your StudioLive with VSL-AI is as easy as drag-and-drop. Load Fat 
Channel presets and scenes by simply dragging them onto the channel or mixer 
overview. You can load Fat Channel presets as a complete channel strip or as 
individual gate, compressor, and EQ presets. Through VSL-AI, you can back up 
all of the scenes and presets stored on your StudioLive. These stored settings 
can be loaded from disk or sent to, and stored internally on, the StudioLive.

Since control is bidirectional, fader moves and parameter changes made on the 
StudioLive are reflected in VSL-AI. So, for example, you can set up the StudioLive 
the way you want it and then save your scene and other presets in VSL-AI.

VSL-AI also lets you create a password for your StudioLive so that you can lock 
out unauthorized users. (See Section 4.8.5 for details.) From the Launcher 
window, you can set basic parameters such as buffer size and sample rate.

To use VSL-AI, you must do one of two things: 

•• Connect and sync your StudioLive to your computer using a FireWire 
s800 cable. This option allows you to use all the features VSL-AI 
provides, including Smaart Spectra Analysis and the Smaart System 
Check Wizards while recording and playing back audio through 
Capture, Studio One, or a third-party DAW of your choice.

•• Connect your StudioLive and computer to the same wireless network. 
This option will allow you to use your laptop to remote control the 
StudioLive AI mixer anywhere in the venue, but the Smaart tools 
will be disabled as these features require an audio driver.

4.1	 Universal Control-AI Launch Window

The Universal Control-AI Launch Window offers basic configuration tools for 
using your StudioLive AI mixer as an audio device on your computer:

Sample Rate. Displays the sample rate set on the StudioLive AI-
series mixer. Because your mixer is always the master clock, the 
sample rate must be set in the System menu on your mixer.

Clock Source. Displays the master clock for the audio driver. 

Power User Tip: As mentioned above, the StudioLive AI mixer is the master 
clock for your audio system. The audio driver is clocked externally by the 
mixer. This means that your mixer will not be forced to reclock (and mute 
its outputs)  if your computer crashes or is accidentally disconnected.
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Safe Mode. Changes How the StudioLive Driver’s Buffer Size is Set.

•• Low Latency. Input and output buffers are both identical to the Buffer Size setting.

•• Normal Mode. Slightly increases the output buffer for typical operation.

•• Safe Mode 1-2. Increases the output-buffer size for added stability.

Block Size (Windows Only). Changes the StudioLive Buffer Size.

You can set the buffer size from 64 to 4,096 samples. The buffer size determines 
the roundtrip time it takes audio data to be converted from analog to digital and 
back to analog. As a general rule, the higher the buffer size, the better the system 
performance, but the less playable virtual instruments and the like become. In 
general, 512 samples (11 to 12 milliseconds) will provide you with a large enough 
buffer for optimum system performance, but low enough to be unobtrusive.

You should set your buffer size prior to launching your host application.

On the Mac, the buffer size is set from inside your host application.

Power User Tip: In the event that audio playback from your computer is distorted 
or choppy, you may need to adjust your Block Size so that it is high enough for your 
computer’s performance capacity. For most modern computers, a Block Size of 32 or 
64 samples will perform quite well in most situations. However, if you have loaded 
several plug-ins that require a large CPU overhead, your computer’s processor is 
older, or you do not have adequate RAM for your use, you may find that a Block Size 
of 256 or higher will allow you to add more plug-ins and tracks. Adjusting the Safe 
Mode to 1 or 2 will also help get better performance out of slower machines.

Device Window Button. Opens the Device Window. 

Click on this button to open Virtual StudioLive-AI (VSL-AI). 
 

File Menu. Opens and Closes Launch and Device Windows. 

From the File menu of the Launch window, you can open and close both 
windows, as well as quit the Universal Control-AI application. 
 
 

•• Show All Devices. Opens the Device window for all 
connected FireStudio-family interfaces.

•• Close All Devices. Closes the Device window for all 
connected FireStudio-family interfaces.

•• About Universal Control-AI. Displays version information for Universal Control-AI.

•• Quit. Quits the Universal Control-AI application.

4.2	 VSL-AI: Browser

When you first launch VSL-AI, notice the browser window along the right side of 
the screen. The browser in VSL-AI functions similarly to the browser in Studio One. 
From the browser, you can see all of the scenes, Fat Channel presets, FX presets, 
and graphic EQ settings that are saved on your StudioLive and on your computer. 
You can also create new settings and can back up your entire library from this 
window. Simply drag-and-drop a scene or preset to load it on your StudioLive.

VSL-AI allows you to back up your scenes, Fat Channel, effects, and graphic EQ 
presets and permanently store them on your computer. Each type of preset can be 
added separately. In this way, you can back up only what you want, when you want.
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VSL-AI makes reorganizing all the scenes and presets stored on your StudioLive as 
easy as dragging-and-dropping a file. To load your StudioLive with new scenes and 
presets, simply drag any scene or preset from the On The Disk section of the browser 
to any position in the Device Memory section of the browser. 
 
 
 
 
 
 
 

To save a scene or preset from your StudioLive on your computer, simply select it 
from the Device Memory section and click the Add to Disk button. 
 
 
 
 
 
 
 
 
 
 
 
 

Browser Tab Buttons. Displays the Different Preset 
Categories on Your StudioLive and Computer.

All of your scenes and presets are contained in dedicated folders in 
VSL-AI. To view a specific set of presets, simply click on its tab.

•• SCENE. Displays stored scenes.

•• FAT CH. Displays stored Fat Channel presets.

•• FX. Displays stored effects presets.

•• GEQ. Displays graphic EQ presets.

•• BACKUP. Displays any backup logs that have been created in VSL-AI. The 
Backup tab allows you to create complete time-stamped snapshots of your 
StudioLive. This can be especially useful when completing a project that 
may need to be revisited in the future. To create a backup, simply click on 
the Backup button. To restore any backup file, select it in the On the Disk 
portion of the browser and drag it into the Device Memory section.

Add New and Remove Buttons. Creates a New or Deletes a Stored 
Scene or Preset.

To the right of the On The Disk section of the browser, you will 
see the Add New and Remove buttons. Clicking the Add New 
button will immediately create a new scene or preset. 

Clicking the Remove button will delete the currently 
selected stored scenes or presets.

Show/Hide Browser. Displays/Hides the Browser Window.

The browser can be hidden from view to provide more real estate for 
your mix. Simply click on the Browser button to close the browser.

To reopen it, click on the Browser button again.
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4.2.1	  VSL-AI: Panel Views

VSL-AI allows you to customize your view based on your screen size and the amount 
of parameters you want to simultaneously view. The DSP, Aux, and FX panels of the 
VSL-AI window are individually available to hide or be shown depending on your 
needs. Additionally, you can choose to hide the Master and Fader sections.

When VSL-AI launches, it automatically reads your screen size and 
opens one, two, or three simultaneous panels, depending whether 
your screen height will support 714, 856, or 994 pixels. 

While in Single Panel mode, the DSP, Aux, and FX panels are only individually visible. 
In Double Panel mode, the DSP panel is always visible but the Aux and FX panels can 
only be viewed one at a time. For screens larger than 994 pixels high, all three panels 
can be view simultaneously or hidden depending on your needs. 
 
 
 
 
 
 

Master. Click this button to show/hide the entire Master Section, including the Main 
bus, Subgroups, FX, and Quick View sections. 

DSP. Click this button to show/hide the Fat Channel Microviews Panel.  

Aux. Click this button to show/hide the Aux Panel. 

FX. Click this button to show/hide the FX Panel. 

Expand/Contract. This feature is only available on screen resolutions large enough 
to add another panel to the window. Clicking the Expand button opens the panel 
below the currently selected panel. Clicking the Contract button closes the 
bottommost panel.

Faders. Click on this button to show/hide the Fader Panel. 

Locate. When the Fader Panel is visible, you can engage Fader Locate mode.  
While in this mode you can view the physical fader position relative to the VSL-AI 
fader position.

At the top of the VSL-AI window, you will see four tabs: Overview, Fat Channel, 
GEQ, and Setup. The Overview tab provides you with a complete graphical 
representation of your StudioLive. As you adjust parameters on the StudioLive, 
you will notice that the VSL-AI overview is also updated. If you use your mouse 
to adjust a parameter in VSL-AI, the StudioLive will be updated remotely. It is 
important to remember that every button, knob, slider, and fader on the VSL-
AI corresponds directly to a button, knob, slider, or fader on your StudioLive.
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4.3	 VSL-AI Overview Tab 

4.3.1	 Metering Controls

At the bottom of the Panel Controls, you will find the Metering Controls. These 
controls correspond directly to the same controls available on your StudioLive AI 
mixer:

Input Metering. Turns PFL input metering on and off. Switches the 
meters to display the pre-dynamics, pre-fader level of the input bus. 

GR Metering. Turns gain-reduction metering on and off. 
Displays the gain reduction of the input bus. 

Output Metering. Turns post-fader output metering on/off. Switches the 
meters to display the post-dynamics, post-fader level of the Input bus. 

Aux Metering Button. Turns aux-bus master out metering on and off. Displays 
the output level of each of the aux and effects buses. Each odd-numbered channel 
meter displays the output level for the aux bus directly above it (Meter 1 shows 
the output level for Aux 1, Meter 3 displays the output level of Aux 2, etc.).
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4.3.2	 DSP Panel & Channel Controls

The Overview Tab provides the same controls for each 
channel that your StudioLive mixer does. The diagram to 
the left illustrates the available channel controls.

The DSP Panel displays microviews of each of the Fat Channel 
components. Double-clicking on any of these components will 
open the Fat Channel tab. The DSP Panel is the only panel that 
cannot be hidden while in Double or Triple Panel modes.

You can also copy and paste Fat Channel settings and load presets using 
these microviews. See Sections 4.3.6 and 4.5.3 for more information. 
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4.3.3	 Aux Panel

When the Aux Panel opens, you will notice the Aux Masters view to the 
far right of the panel. The Masters view displays the controls for each 
aux bus as the controls appear on the StudioLive. The Masters view also 
displays the send levels for the Aux Flip Mode Channels (Main Digital 
Return, Tape Input, Aux In A and B, FXA, FXB, FXC, FXD, and Talkback).

From within the Masters view, you can also select each 
aux bus to edit its Fat Channel insert.

Click on the pull-down menu to quickly select a different aux. 

From the Masters view, you can also choose between two different views 
of your aux mixes.  

The Aux Overview displays the aux-send levels for every aux bus on every channel.

Power User Tip: To quickly set up an aux mix, use your mouse to set the 
send level for Channel 1. Right-click on the Channel 1 send level and 
sweep your mouse across the other channel sends for that aux. The 
send level will be copied to every other channel for that aux.

The Aux Sends view displays the aux mix for an individual aux 
bus. To select a different aux mix, simply click on that aux’s tab. 
While in this view, you can also stereo link aux buses.
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4.3.4	 FX Panel

The FX panel provides an overview of the FX send levels 
for all four FX buses on every channel.

Power User Tip: To quickly set up an FX mix, use your mouse to set the 
send level for Channel 1. Right-click on the Channel 1 send level and 
sweep your mouse across the other channel sends for that FX bus. The 
send level will be copied to every other channel for that FX bus.

The FX masters view allows you to select the FX type and adjust its parameters. 
Use the tabs on the right of the FX Masters view to switch FX buses.

Tap Tempo (FXC and FX D only). VSL-AI allows you to remotely control the Tap 
Tempo function for a delay loaded on both the FXC and FXD buses. Clicking on it 
repeatedly will change the Time parameter to match the tempo entered.

4.3.5	 Copying Mixes

Next to the main fader, and in each of the aux masters, you will see the Copy Mix 
handle. When selected with your mouse, this handle lets you drag-and-drop the mix 
for that bus to another bus. In this way, you can drag the main-fader mix to Aux 1 to 
set a starting point and can quickly give the singer the same mix on two different 
floor wedges.

Note: While the main mix can be copied to any aux, aux mixes can 
only be copied to other aux mixes and not to the main mix.

4.3.6	 Copying Channel Settings

VSL-AI provides you with two ways to copy channel settings from 
one channel or bus to another. The first method functions essentially 
like you StudioLive hardware; the second is unique to VSL-AI.

Copy Channel (Copy/Paste)

StudioLive AI mixers give you the ability to quickly copy-and-paste a single 
channel or bus’s Fat Channel settings onto multiple channels and buses. 
VSL-AI provides the same functionality in exactly the same way.

To copy a channel or bus, simply select it and click the Copy button. All the Select 
buttons will flash. Click the Select buttons for the channels and buses to which you 
want to copy the Fat Channel settings. When you are done, click Paste.

Note: Subgroup and main bus assignments are only copied from channel to channel.
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Copy Channel (Drag-and-Drop)

At the top of the VSL-AI window, you will see the Copy Channel handle. This handle 
follows the selected channel and lets you drag-and-drop all the Fat Channel and bus 
assignments for that channel onto another channel or bus.

Note: Channel bus assignments are only copied from channel to channel. 
 
 
 
 
 
 
 
 
 

VSL-AI also allows you to copy individual Fat Channel components from one channel 
to another. For example, to copy only the Compressor setting from Channel 1, simply 
drag and drop the Compressor microview to another channel. 
 
 
 

4.3.7	 Quickview

At the top of the Master Section of the Overview tab, you will find the Quickview. 
This allows you to view the Focus GEQ, Mute Groups, and Quick Scene controls.

GEQ in Focus

In general, graphic EQ settings are created prior to a live show and 
are not adjusted after that. However, minor adjustments sometimes 
must be made later. VSL-AI makes this quick and easy.

You will have noticed that there is a GEQ above the 
Master section on the Overview tab. 

Here, you can focus any GEQ in one of two ways:

•• Select a GEQ on the GEQ Tab. For example, if you leave Aux 8’s GEQ in focus 
on the GEQ tab and switch back over to the Overview tab, you will still be 
able to adjust Aux 8’s GEQ using the Focus GEQ above the Master section.

•• Select the GEQ from the GEQ Focus Menu. In the upper left corner of the GEQ 
in Focus, you will find a pull-down menu. From this menu, you can select 
any of the 16/12/8 graphic EQs to put into focus on the Overview tab.
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Mute Groups

The Mute Groups tab in the Quickview mirror the functionality of 
the Mute Groups section on the StudioLive 32.4.2AI. See Section 
4.7 in the StudioLive AI Mixers Owner’s Manual for details.

Quick Scene

Like the StudioLive 32.4.2AI, VSL-AI allows you to save scenes to Quick Scene buttons 
for easy recall. See Section 5.3.6 in the StudioLive AI Mixers Owner’s Manual for details.

Power User Tip: You can also preload scenes to any of the Quick Scene buttons 
by simply dragging and dropping a saved scene onto any of the buttons.

4.4	 VSL-AI: Fat Channel Tab

The Fat Channel tab provides a detailed overview of the Fat Channel parameters 
for the selected channel. The selected channel will always be shown in the 
upper left corner. It is important to remember that you have continuous 
bidirectional control. If you grab a point in the EQ with your mouse, for example, 
you will change the parameters both in VSL-AI and on your StudioLive.

Power User Tip: The Fat Channel tab can also be opened by double-clicking on 
any of the microviews on the Overview tab. The Fat Channel tab will open with the 
selected parameter in view. For example, if you double click on the EQ microview 
on Channel 4, the Fat Channel tab will open displaying the full EQ for Channel 4.

The Fat Channel tab also provides Smaart Spectra™ analysis on the EQ. 
For more information on the Spectra tools, please see Section 4.7.
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4.5	 Loading Scenes and Presets from VSL-AI

As stated in earlier, the browser window in VSL-AI functions in much the same way 
as the browser in Studio One. To load a scene or preset from the browser window, 
simply select it and drag it over the mixer or channel on which you wish to load 
it. Scenes and presets can be dragged from either the On the Disk or the Device 
Memory section of the browser and dropped onto the Overview or the Channel tab.

4.5.1	 Loading a Scene

To load a new scene on your StudioLive, select it from the browser window and drag 
it over the mixer in either the Overview or the Channel tab. The window will gray out, 
indicating that a new scene is about to be loaded. Note that only the parameters 
that have been enabled for recall on the StudioLive will be recalled on the mixer.

4.5.2	 Loading Scribble-Strip Labels

Scribble-strip labels are stored with your scenes. You can load just the labels by 
selecting the scene from the browser and dragging it over the row of scribble 
strips above the channel faders. The scribble strips will gray out, indicating 
that the scribble-strip labels from the scene are about to be loaded.

4.5.3	 Loading a Fat Channel Preset

To load every component in a Fat Channel preset (gate, compressor, EQ, etc.), select 
the preset from the browser and drag it over any part of the desired channel.
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If you drag the preset over any of the component microview, VSL-
AI will load only that component (e.g., if you drag a preset over the 
compressor microview, only the compressor will be loaded).

4.5.4	 Loading an FX Preset

To load an FX preset, select it from the browser window and drag it onto 
the FX Master section on the FX Panel. Once it is loaded, you can use 
the FX Type menu to change the effect and create new presets.

Note: As with StudioLive hardware, VSL-AI can only load reverb 
presets on FXA and FXB and delay presets on FXC and FXD

4.5.5	 Loading a GEQ Preset

To load a graphic EQ preset, select it from the browser and drag it over 
any part of the focused graphic EQ. Graphic EQ presets can be loaded on 
the Overview tab or the GEQ tab. Once a preset is loaded, you can use the 
sliders in VSL-AI or the encoders on the StudioLive to make adjustments.
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Note: You must be in the GEQ menu page and have the graphic EQ you wish to control 
selected in order to use the encoders on your StudioLive to control each graphic EQ in 
VSL-AI. See the Section 5.4 in the StudioLive AI Mixers Owner’s Manual for details.

4.6	 VSL-AI: GEQ Tab

The StudioLive AI Mixers feature a graphic EQ for each of the aux buses and a stereo 
graphic EQ for the main bus. In addition to allowing you to control each graphic 
EQ individually, VSL-AI automatically links both mono graphic EQs to create a true 
stereo graphic EQ if the pair is inserted onto a stereo bus, allowing you to control 
both sides at once. (For example, if you insert stereo-link Aux 1 and 2, their graphic 
EQs will function as a stereo graphic EQ rather than a dual-mono graphic EQ.)

From the GEQ tab, you also have access to Smaart Spectra™ analysis tools. These 
tools can be used to ring monitors, view the frequency spectrum of your mix, or 
check the overall output level of a bus. See Section 4.7 for more information.

Note: The GEQ menu on your StudioLive does not have to be active to make changes 
to a graphic EQ from VSL-AI. If you wish to use the Fat Channel encoders to control 
the graphic EQs in VSL-AI, then you must open the GEQ menu on your StudioLive. 
See Section 5.4 in the StudioLive AI Mixers Owner’s Manual for details.

4.6.1	 Selecting a GEQ to Edit 

Along the top of the GEQ tab, you will see another set of tabs, one for each dual-
mono GEQ. To bring a GEQ in focus so that you can edit it, simply click on its tab.

Power User Tip: If a bus is stereo-linked, the graphic EQ will link automatically.

4.6.2	 Enabling a GEQ

By default, all graphic EQs are disabled. To enable them remotely via VSL-AI, simply 
click on the Enable button to the left of the sliders.

4.6.3	 Flattening a GEQ Curve

To zero out all curve settings on any graphic EQ, click on the Flatten GEQ button, 
which is directly below the Enable button. This will flatten all band gains to 0 dB so 
that they neither boost nor attenuate any of the 31 bands.

4.7	 Enabling Smaart Analysis (GEQ and PEQ)

Both the GEQ and Fat Channel tabs provide Smaart Spectra analysis. Smaart Spectra 
was developed by Rational Acoustics to power Smaart’s Spectrum Measurement 
Engines and includes an RTA and a spectrograph.

By default, Smaart analysis is disabled. While Smaart is disabled, you have control over 
which bus is routed to the second to last pair of Auxiliary Inputs (45-46/37-38/29-30).

Clicking on the Spectrograph or RTA buttons will start Smaart, and 
VSL-AI will take control over Auxiliary Inputs 45-46/37-38/29-30.

For more information on the Auxiliary Inputs Router, please see Section 4.8.1.

Note: Smaart analysis requires use of the StudioLive’s onboard audio interface. It is not 
available without a FireWire connection between your mixer and your computer.
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4.7.1	 Time-Frequency Spectrograph

Clicking on the Spectrograph button (from the Fat Channel EQ 
or GEQ tab) will launch the Time-Frequency Spectrograph. This 
spectrograph provides a three-dimensional view of your audio in 
which x = frequency, y = time, and color = decibel level.

Any signal below the lower dynamic-range threshold is black. Any signal above 
the top dynamic-range threshold is white. Within the dynamic range, colors go 
from blue to green to red, with blue indicating the quietest and red the loudest.

Many audio signals that are encountered in the field are highly dynamic. Musical 
signals, speech, and even environmental noise contain significant changes in spectral 
content as a function of time. The spectrograph can be thought of as a record of 
multiple RTA measurements taken over time, with color representing amplitude.

Using this function, the spectral content of the input signal is recorded as it changes 
in time. This allows you to view and analyze time-varying trends in the input signal.

As a troubleshooting tool, the spectrograph is useful for finding spectral “defects” 
in a system or acoustical environment. Certain audio signals or acoustical events 
contain specific traits that can be easily detected due to their distinct time/
frequency signature—specifically, highly tonal sounds such as AC line noise 
in an electrical signal chain or the presence of electro-acoustical feedback.

Dynamic Range

VSL-AI provides you with dynamic-range sliders for the spectrograph. These sliders 
set the maximum and minimum volume thresholds for the spectrograph. 
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4.7.2	 RTA

 

Clicking on the RTA button (from the Fat Channel EQ or GEQ tab) will launch 
a real-time analyzer in which x = frequency and y = amplitude. An RTA 
provides a close visual representation of what you are hearing. It provides 
a view of the long-term spectrum of the signal—for example, the one-
third-octave spectrum long-term average of a musical performance.

Averaging

While the RTA is engaged, you can adjust its averaging speed. When using music in 
test measurements, it is often necessary to average the data over a brief amount of 
time. This is because most musical signals do not have energy at all frequencies all of 
the time.

Averaging is a mathematical process that takes multiple data samples and performs 
division to acquire a statistically more accurate calculation of the response. That’s a 
technical way of saying that it slows down the “real-time” of a real-time analyzer.

4.7.3	 Using the Smaart Spectrograph to Ring Out Monitors

The spectrograph shows frequency data over time, so a constant frequency, 
such as feedback, results in a straight line in the spectrograph. Feedback is 
short term for a feedback loop, where a portion of the signal from the speaker 
returns to the microphone, resulting in a constant tone at the offending 
frequency. “Ringing out” is a process of attenuating the frequencies that are 
feeding back to maximize gain before feedback in your floor monitors.

1.	 With the mic input gain at an appropriate level, bring the aux-
send level up on the mic channel you wish to ring.

Power User Tip: If you are using one console for stage monitors and another 
console for front-of-house, set the mic input gain on the front-of-house 
console. Do not “gain up” the mic signal on the monitor mixer for the sake 
of getting more volume out of a stage monitor, as you can do that in other 
places (Mix level for individual channels, Aux Out level for global control, etc.). 
Gain staging is very important in order to have a feedback-free show.

2.	 Click on the GEQ tab in VSL-AI and select the graphic EQ assigned 
to the aux output of the stage monitor you are ringing out.

3.	 Enable the spectrograph.
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4.	 Slowly bring the aux output level up until you hear (and see) feedback.

Note: Ringing out stage monitors will produce feedback. If you are not careful, 
you can produce a lot of feedback. Do not make sudden gain boosts; go 
slowly and carefully to avoid causing any damage to speakers and ears.

5.	 Feedback will show up as a solid line on the spectrograph and as 
a line peak on the RTA. Use the dynamic threshold to adjust how 
bright, and at what input level, the frequency information plots.

6.	 Lower the GEQ fader for the offending frequency in 3 dB 
increments to attenuate it out of your stage monitor.

Power User Tip: Bring back the level on the GEQ slider to the point just before feedback 
so you don’t take out too much frequency content and sacrifice overall timbre. 
Because the speaker is pointed at the mic, stage-monitor feedback typically occurs 
in the higher frequencies, which also is where intelligibility comes from. Maximizing 
your intelligibility and gain structure results in clearer-sounding monitors.

You can apply this process to the main system, as well. This is especially useful 
with applications requiring lavaliere or podium mics. These types of microphones 
are typically omnidirectional condensers and are very prone to feedback.

In a main system, feedback is typically in the mid to low range. The 
frequencies that are regenerating and creating a feedback loop 
are those frequencies that are wrapping around the main system 
due to the loss of directional control of lower frequencies.

When you are ringing out a system, and more than two or three feedback 
loops are happening simultaneously, you have reached the level where 
stability can no longer be achieved. Try bringing down the overall output level 
or find a physical solution, such as moving the speaker or microphone.

4.7.4	 Using the Smaart RTA While Mixing

The RTA and spectrograph have useful applications beyond recognizing feedback 
spikes. The ability to analyze frequency content—specifically, being able to 
visualize the exact frequencies you are hearing in order to home in on problem 
areas— makes the RTA a secret weapon for many a mix engineer. The Smaart 
Spectra tools also lend themselves very well to ear training and give you confidence 
that you are choosing the right frequencies when making adjustments.

Because the RTA/spectrograph is analyzing the bus signal digitally, room and speaker 
anomalies are taken out of the equation. This provides a pure measurement of 
your mix because you are measuring what is happening inside your StudioLive.

A spectrograph shows the broadband information of a signal, making it easy to 
view the fundamental frequency of a source, as well as its harmonic structure. 
The RTA is a view of amplitude and frequency content over a specified plane. 
With the spectrograph, you can view what is happening in your signal now, at the 
same time you are viewing what happened moments before. In contrast, there 
is no history information for the RTA: Once an event happens, it goes away.

Power User Tip: Both the RTA and Spectrograph views are useful in understanding what 
the spectral content of an instrument is when creating space for that instrument in a 
mix. How you use these tools to achieve an objective is a matter of your subjective, or 
creative, goals. Trust your ears and use the Spectra tools to verify what you are hearing.

For example, let’s say you are mixing a particularly edgy-sounding lead guitar 
that is competing with the male vocal and distracting from the overall good 
tone of the instrument. By using the RTA in the Fat Channel, you can quickly 
identify the offending frequency by looking for spikes in the RTA. This saves 
time and frustration by taking some of the guesswork out of equalization. 

Power User Tip: It should be noted that neither a spectrograph nor an RTA can 
be used as a substitute for careful listening. While these tools provide a great 
visual analysis of your mix, critical listening must always be your main guide.
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4.8	 VSL-AI: Setup Tab

The Setup tab allows you to customize VSL-AI and your StudioLive, 
route your auxiliary digital inputs, and set some user preferences.

4.8.1	 Auxiliary Inputs Router

In additions to the 32/24/16 input channels, the StudioLive AI-series mixers allow 
you to route any 16 of 27/23/19 buses and other inputs. This is done via the Auxiliary 
Inputs Router on the Setup tab. To route Digital Sends 33-48/25-40/17-32, first 
decide which buses and inputs you would like to record in addition to your input 
channels. Once you’ve determined your input pairs, simply patch them to a stereo 
pair of auxiliary inputs of your choice. Remember, all of these buses and inputs are 
automatically set to send their signals post-Fat Channel dynamics and post-EQ 
(where applicable). The inputs and buses selected in the Auxiliary Input Router will 
be displayed in your recording application, along with the name of their routing.

For instance, the routed pairs on the StudioLive 32.4.2AI in the above picture 
would translate as the following chart in your host recording application:

PHYSICAL SOFTWARE

Main Mix Left Auxiliary In 33

Main Mix Right Auxiliary In 34

Subgroup 1 Auxiliary In 35

Subgroup 2 Auxiliary In 36

Subgroup 3 Auxiliary In 37

Subgroup 4 Auxiliary In 38

Aux Send 3 Auxiliary In 39

Aux Send 4 Auxiliary In 40

Aux In A Left Auxiliary In 41

Aux In A Right Auxiliary In 42

FXA Send Auxiliary In 43

FXB Send Auxiliary In 44

FXC Send Auxiliary In 45

FXD Send Auxiliary In 46

Tape In (L) Auxiliary In 47

Tape In (R) Auxiliary in 48

The Auxiliary Inputs Router also allows you to designate a specific bus to the S/PDIF 
output, as well as enabling you to select which stereo pair will be recorded on 
the auxiliary stereo track in Capture 2. When the StudioLive is not connected to 
a computer, the S/PDIF output can be routed using the System menu. However, 
when your StudioLive is synced to your computer, you can route any of the 
27/23/19 available buses or inputs to the S/PDIF output by routing them to 
Digital Sends 47-48/39-40/31-32. In addition to being available for recording via 
these Auxiliary Digital Inputs, these sends are normalled to the S/PDIF output.

As previously mentioned, if Smaart Spectra tools are engaged, 
VSL-AI will take control of Auxiliary Inputs 45-46/37-38/29-30. 
When VSL-AI has control, these inputs will be grayed out.



4	 Universal Control-AI and VSL-AI 
4.8	 VSL-AI: Setup Tab

StudioLive™ AI Software Library 
Reference Manual

36

4.8.2	 Scene Recall Filters

Your StudioLive allows you to decide which group of parameters you would like to 
recall with a scene. The Scene Recall menu on the Setup tab corresponds directly 
with the Scene Recall menu on your StudioLive. See Section 5.3.4 in the StudioLive 
AI Mixers Owner’s Manual for details. 
 
 
 
 
 
 
 

4.8.3	 Link Channel Faders Preference

When the Link Channel Faders preference is enabled, stereo-linked channels will no 
longer have individual control over each fader in VSL-AI or StudioLive Remote-AI. This 
allows you to control the volume of a stereo channel pair by moving either 
channel’s fader.

4.8.4	 Default to Fader Locate Preference

With the Default to Fader Locate preference enabled, Fader Locate will automatically 
engage when a fader is moved remotely in VSL-AI or StudioLive Remote-AI. This 
preference allows you to quickly sync your StudioLive when you return to the board.

Power User Tip: If you are remote-controlling the faders on your StudioLive, 
it is highly recommended that you enable this preference. When Fader 
Locate mode is activated, the faders on your StudioLive will not be active. 
By allowing this mode to engage automatically, you will instantly see 
which faders have changed when you go back to the StudioLive.

4.8.5	 Enabling Lockout Mode

Your StudioLive features a Lockout mode that allows you to temporarily disable 
nearly every feature on the StudioLive, although analog features (e.g., input-trim 
knobs, faders, and cue, tape-input, and monitor levels) can still be adjusted.

Because of this, after unlocking your StudioLive, and before resuming 
mixing, you should take a quick glance at your input trims and output levels. 
If you have locked your fader position, you will be able to recall your pre-
lockout fader positions using the Locate button in the meter section.

Until you connect your StudioLive to a computer, the mixer cannot be 
locked, so don’t worry about accidentally locking yourself out.

1.	 With your StudioLive connected and synced to your 
computer, launch VSL-AI and click on the Setup tab.

2.	 Click on the Lock Out button. 

3.	 To set your custom password, click on the box next to “Device 
is Lockable.” At this point, a cursor will appear in the password 
box. Enter a 5-digit code using any number between 1 and 9, 
and click the Set button. Your password will no longer be 
displayed. Should you need to change your password, simply 
click on the box next to “Device is Lockable.” Your old 
password will be deleted, and you will be able to enter a new 
password. Once you have set your password, the StudioLive 
can be locked whether it’s synced to a computer or not.
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4.	 To lock your StudioLive, press the System button in the Digital Effects | Master 
Control section. 
 
 
 
 
 
 
 

5.	 Navigate to the Lockout menu. Your StudioLive cannot be 
locked unless this page is active. 
 
 
 
 

6.	 To lock your StudioLive, press the Select buttons that correspond to the 5-digit 
password you have set. In this example, the password is 12345, so you would press 
the Select buttons for Channels 1, 2, 3, 4, and 5, in that order. The Panel Status will 
switch to Locked, indicating that Lockout mode is active. 
 
 
 
 
 

7.	 To unlock your StudioLive, navigate back to the Lockout page in 
the System menu on your mixer, if this page is not currently active. 
Press the same sequence of Select buttons. The Panel Status will 
change to Unlocked, and you will be able to resume your mix.

Power User Tip: At its lowest level of security, Lockout mode allows you to 
freeze the current Fat Channel and effects settings. Faders, aux mixing, master 
section functions like talkback and monitoring, and scene recall are still 
functional. Each of these mix functions can be added to Lockout mode.

4.9	 Smaart System Check Wizards 

VSL-AI also includes three System Check Wizards to provide you with the 
ability to view the frequency response of the venue; quickly calculate 
and set delay system timing; and verify output connectivity. 

Traditionally, in professional sound reinforcement, the mixing console is there to 
mix, and the system processor is there to align and tune the speaker system. When 
functioning and set correctly, the system processor is invisible to everyone but 
the System Engineer. For the first time, the tools used to tune and align speaker 
systems are built into the mixing console itself and accessible to any engineer 
who wants to improve their PA’s sound and get the most out of their PA system.

For all but the most seasoned professional sound technician, this is a new extra 
step in the process of setting up for a show. For most FOH engineers, getting a 
good mix is a big victory. But imagine being able to recreate that same killer mix 
night after night, show after show. Once the system has also been optimized 
for the environment it is in, any FOH engineer working on it will achieve that 
big victory without so much work. This is why system alignment is a standard 
procedure in professional level sound reinforcement. Again, this solution is not 
typically achieved from the mixing console, but built into the system design 
itself. The Smaart System Check Wizards in VSL-AI merge these two worlds.
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Clicking on the Smaart button at the top of the VSL-AI window will launch Smaart 
System Check mode. While in this mode you can launch any of the following wizards: 

•• SRA: Smaart Room Analysis generates a frequency-response trace 
and overlays it on the parametric EQ in VSL-AI so you can adjust 
your system to get rid of unwanted anomalies in the room.

•• SSD: Smaart System Delay calculates and sets the correct 
amount of delay time between two full-range systems.

•• SOC: Smaart Output Check verifies that your system 
outputs are routed correctly and are passing signal.

To run any of the Smaart System Check Wizards, VSL-AI will need 
to take over your mixer. When you first click on the Smaart System 
Check button, you will see a warning to this effect.

Clicking on the “Proceed” button will launch the Wizard select window 
and you will no longer have control over your mixer. You can exit 
the Wizards and regain control at any point simply by clicking on 
the Overview, Fat Channel, GEQ, or Setup tabs in VSL-AI.

Note: To run the SRA and SSD wizards, you will need to connect a measurement 
microphone to your StudioLive’s Talkback input. You’ll also need a mic stand 
and a long enough cable to place the mic in front of your speakers.

A measurement microphone is special type of condenser microphone that is designed 
to provide an accurate reproduction of a room’s sound characteristics for use with 
audio-analysis tools, such as RTAs and spectrographs. Measurement microphones 
typically have an omnidirectional polar pattern and deliver a very flat frequency 
response between a low end of 5 Hz to 30 Hz and a high end of 15 to 30 kHz. While 
measurement microphones can be quite expensive, most affordable models will do 
the job nicely when paired with the Smaart System Check Wizards. PreSonus offers 
the budget-priced PRM1 Precision Measurement Microphone for this purpose.

4.9.1	 Smaart Room Analysis Wizard

The SRA Wizard is an automated process that will guide you through the steps 
of acquiring a frequency-response trace for your audio system. A frequency-
response trace is the plotted result (frequency and amplitude) of the system 
measurement. This measurement is calculated using Rational Acoustics’ 
transfer function, which is a set of proprietary algorithms that compare the 
signal from a measurement mic to computer-generated pink noise.

Sound SystemReference Signal
(Input Signal)

Measurement Signal
(Output Signal)

Reference Channel RTA
(Pink Noise)

=

Measurement Channel RTA

Frequency Response Trace
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1.	 To launch the Room Analysis wizard, click on the Room Analysis tab.

2.	 You will be instructed to connect a measurement microphone to the Talkback 
input on the back of your StudioLive AI mixer. 
 
 
 
 

3.	 Set the Talkback trim pot on the back of your mixer to 12 o’clock. 
 
 
 
 
 
 
 
 

4.	 You will be asked which output you would like to analyze. Stereo-
linked outputs will be listed as stereo; for example, if Aux 1 and 
Aux 2 are stereo-linked, they will be listed as Aux 1/2.

5.	 Click OK to start the wizard.

Next you will be asked to pick the type of analysis you would like to do. Basic 
Analysis requires you to take a single measurement of your system. When analysis 
is complete, the wizard will continue to output pink noise through your system 
while you EQ, allowing you to view the effects of your filters in real-time.

Advanced Analysis requires you to take three separate measurements 
and will generate a more accurate frequency-response trace of your 
system by averaging the measurements together. Once the trace has 
been generated, this wizard will not continue to analyze your system. To 
view the effects of your filters, you must run the wizard again. Skip to the 
next part of this section for more information on Advanced Analysis.

WARNING: Power down unit before removing option card

WARNING: Power down unit before removing option card
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Basic Analysis

1.	 Select Basic Analysis from the pull-down menu.

2.	 Place your microphone on-axis in front of the speaker you want to analyze. If you 
are analyzing a stereo bus, place your microphone on-axis in front of the Left 
speaker. See Section 4.9.5 for tips in choosing the best primary mic position.

1

3.	 Click OK when your microphone is properly placed.

4.	 It is now time to make some noise—pink noise, that is. Raise the fader until 
the pink-noise output through your speaker is louder than the ambient 
noise floor in the room. At the appropriate measurement level, you 
should not hear the air conditioning, traffic noise from the street, etc.

5.	 To mute the pink noise at any time, simply click on the Speaker icon.

6.	 Click OK when the pink noise is at the appropriate level.
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7.	 Click Analyze to generate the frequency-response trace.

8.	 Adjust the EQ to shape the frequency-response into the correct trend for your 
application. (See Sections 4.9.6 and 4.9.7 for best practices.) In general, you do 
not want to boost any frequencies, and you do not want to make any cuts greater 
than 6 dB. The frequency-response trace will refresh as you make your changes.

9.	 Disable the Analyze button to continue to make EQ adjustments 
without refreshing the trace and to turn off the pink noise.

10.	Click Exit to complete the wizard.

Advanced Analysis

1.	 Select Advanced Analysis from the pull-down menu.

2.	 Place your microphone on-axis in front of the speaker you want to analyze. If you 
are analyzing a stereo bus, place your microphone on-axis in front of the Left 
speaker. See Section 4.9.5 for tips in choosing the best primary mic position.

1
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3.	 Click OK when your microphone is properly placed.

4.	 Raise the fader until the pink-noise output through your speaker is louder than 
the ambient noise floor in the room. At the appropriate measurement level, 
you should not hear the air conditioning, traffic noise from the street, etc.

5.	 To mute the pink noise at any time, simply click on the Speaker icon.

6.	 Click OK when the pink noise is at the appropriate level.

7.	 Click Analyze to generate the first frequency-response trace.

8.	 Place your microphone off-axis in front of the same speaker. See Section 
4.9.5 for tips in choosing the best secondary mic positions.

2

9.	 Click OK when your microphone is properly placed.
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10.	Click Analyze to generate the second frequency-response trace.

11.	Place your microphone in a different off-axis position in front of the same 
speaker. See Section 4.9.5 for tips in choosing the best secondary mic positions.

3

12.	Click OK when your microphone is properly placed.

13.	Click Analyze to generate the third frequency-response trace.

14.	Adjust the EQ to shape the frequency response into the correct 
trend for your application. (See Sections 4.9.6 and 4.9.7 for best 
practices.) In general, you do not want to boost any frequencies 
and you do not want to make any cuts greater than 6 dB.

15.	Click Exit to complete the wizard.

To view the effects of your filter on the system, run the Room Analysis wizard again. 

Power User Tip: In most cases, you will want to EQ the left and right side of a 
stereo system the same. This is why the SRA wizard asks you to measure the left 
side of your system only and linked buses are displayed as such. If you are in an 
unusual situation where you need to separately EQ each side (say, you are using 
a different model 15-inch speaker on the left side than you are on the right side), 
connect your system to a pair of subgroup outputs and do not link them.
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4.9.2	 Smaart System Delay Wizard

Using multiple sets of speakers in a live performance can make a huge difference 
in the quality of the sound. Rather than relying on a pair of front-of-house speakers 
to fill the entire room, you can create listening zones throughout the room so 
that your front-of-house system only needs to be loud enough to cover the 
front of the room. This allows you to lower the level, give the front row listeners’ 
ears a break, and get better fidelity from your speakers. Sounds great, right?

However, it’s not as easy as just bringing an extra pair of speakers. Any additional 
sets of speakers will need to be delayed; otherwise the audience will perceive 
that the sound is coming from the walls, rather than from the stage. Even 
worse, since electricity travels much faster than sound, listeners in the rear of 
the room are likely to hear the sound coming from the nearest set of speakers 
before they hear the sound from stage, which can dampen the attack and 
intelligibility of the sound and create an unpleasant phasing effect. To compensate, 
you need to delay the signal going to the additional sets of speakers.

Sound travels at a rate of 1,130 feet per second, providing that the temperature, 
humidity, and air pressure are all “normal.” Therefore, it takes 1 ms for sound to travel 
1.1 feet. But what if you’re setting up for an outdoor show in, say, Baton Rouge, 
Louisiana, in August, when the temperature and humidity are unpleasantly far above 
“normal”? Your calculations might be a little off, unless you happen to be a whiz at 
calculating the effect of barometric and atmospheric pressure on sound waves.

The SSD wizard is an automated process that calculates and sets the correct 
delay time between two full-range systems. The purpose of this wizard is to 
set the delay time for a secondary system that is being fed from one or more 
subgroups. No calculators, slide rules, or finger-counting are necessary!

STAGE

FOH L FOH R

Side Fill
(left)

Side Fill
(right)

Rear Fill
(left)

Rear Fill
(right)

30 Feet

40 Feet 37 Feet 

inconveniently positioned column

30 Feet
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In the above example, you see three sets of speakers: main front-of-house, 
sidefills for the middle of the room, and rear fills for the back. As a general 
rule, you should set the delay on a satellite system based on its distance 
from the next closest system to the mains. In this case, you’ll set the delay 
on the sidefills based on their distance from the main front-of-house system 
and the delay for the rear fills based on their distance from the sidefills.

When using the SSD wizard for the above system, you would run the 
wizard four times. The first time, you’d use the main front-of-house left 
for the main system and the left sidefill for the delay system. The second 
time, you will use the left sidefill as the main system and the left rear-fill 
for the delay system. Then repeat the procedure for the right side.

Note: it is important that you set the delay on the first satellite pair 
before you set the delay on the subsequent satellite pair.

Power User Tip: Because rooms often have inconveniently placed architectural features—
fire exits, tables, and so on—the left and right side of a system with satellites will rarely 
be equidistant on both sides of the system. Because of this, you need to run the wizard 
for each side of a stereo system, starting at the front and working your way to the back.

Please note: the SSD wizard is not designed to analyze systems that include a subwoofer. 
Temporarily disconnect or disable your subwoofer before beginning analysis.

System Delay Wizard

1.	 To launch the System Delay wizard, click on the System Delay tab.

2.	 Connect your measurement microphone to the Talkback input on the back of your 
StudioLive AI mixer. 
 
 
 
 

3.	  Set the Talkback trim pot on the back of your mixer to 12 o’clock. 
 
 
 
 
 
 
 
 
 

4.	 From the top pull-down menu, select the speaker output you 
want to delay. Note: Only Subgroup Outputs 1 through 4 can 
be delayed. 
 
 
 

WARNING: Power down unit before removing option card

WARNING: Power down unit before removing option card
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5.	 From the bottom pull-down menu, select the speaker output 
to which you’d like to align. This can be your main outputs or 
any of the subgroup outputs, even if the subgroup outputs 
have been delayed. 
 
 
 

6.	 Click OK to start the wizard.

7.	 Place your microphone on-axis in front of the speaker you want to delay. 
See Section 4.9.5 for tips in choosing the best primary mic position.

1

8.	 Click OK when your microphone is properly placed.

9.	 Raise the fader until the pink noise outputted through your main system 
(the speaker to which you want to align) is louder than the ambient noise 
floor in the room. At the appropriate measurement level, you should 
not hear the air conditioning, traffic noise from the street, etc.

10.	To mute the pink noise at any time, simply click on the Speaker icon.
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11.	Click Analyze.

12.	 If necessary, adjust the pink noise level for your delay system (the speaker you 
want to delay) so that it is louder than the ambient noise floor in the room.

13.	Click Analyze to calculate the delay time.

14.	When the wizard is finished, you will be shown the measured delay time.

15.	  Click Apply to set that measure delay time on the subgroup out.

16.	Click Exit to leave the wizard.

Note: For delay times between 0 and 50 ms, the delay will be set to the nearest 
0.5 ms; between 51 and 100 ms, the delay will be set to the nearest 1 ms; and 
between 102 and 300 ms, the delay time will be set to the nearest 2 ms.
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Once you have positioned and delayed your satellite system, you will want to 
match the output levels of the main and delay systems. To do this, use an SPL 
meter to match the output of the main and delay systems at the delay-system 
measurement position. This means that if you are standing 20 ft from the left side 
of the main system and 30 ft from the left side of the delay system, and the output 
of the main system is 85 dB, the output of the delay system should also be 85 dB.

FOH Mix Position

Delay System 
Measurement Position:
1) Frequency Response 
          (SRA Wizard)
2) Delay Time 
          (SSD Wizard)
3) SPL Reference Point

MAIN

DELAY

4.9.3	 Smaart Output Check Wizard

It’s five minutes before a show, and suddenly the drummer says there’s nothing 
coming out of his monitor. Or you do a friend a favor and run sound at her club 
because she has the flu, and you show up not knowing which aux is connected 
to what monitor or which sub is controlling what sidefill. The Smaart Output 
Check wizard was designed to make these problems disappear like magic!

By momentarily taking over the routing and volume control of an output and 
patching pink noise to it, the Smaart Output Check wizard lets you quickly 
discover which speaker is connected where and helps you quickly get to the 
root of a routing problem. In the case of the drummer with silent monitor, if he 
hears pink noise, you can save yourself ten minutes of frantic cable tracing only 
to discover the output level was inadvertently turned down on his aux mix.

Click on the Output Check tab to use the Smaart Output Check wizard. You will be 
shown buttons for all outputs on your StudioLive. Click on an output’s button, and 
pink noise will fade in for three seconds. You can click on the button again to stop it.

To adjust the pink noise, use the fader on the right side of the page. 
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4.9.4	 Go Remote

At any point during any of the Smaart System Check wizards, you can 
switch over to iPad control using SL Remote-AI. This allows you to continue 
to the next step of the wizard without having to walk back to front-of-
house, which is especially useful when placing your measurement mic.

1.	 Follow the instructions in Section 3 and network your 
iPad, computer, and StudioLive AI mixer.

2.	 Launch SL Remote-AI on your iPad and connect to you StudioLive 
from SL Remote-AI See Section 5 for more information.

3.	 SL Remote-AI will launch to a warning page telling 
you that the device is under test.

4.	 From the Smaart System Check Wizards, click on the Go Remote button. This 
will pull down a menu of connected iPads. Select your iPad from the list.

5.	 You can now continue the wizard from SL Remote-AI.

Power User Tip: An iPad does not have to be given front-of-house permission to 
be listed in the Go Remote list. The advantage of this is that you can grab any iPad 
that happens to be handy to take the Smaart System Check wizards with you.
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4.9.5	 Mic Position

The SRA and SSD wizards do all of the calculations and complex routing through the 
StudioLive for you. Two very important decisions are up to you: Where to place the 
mic and, in the case of the SRA wizard, what to do with the frequency-response trace.

Improper mic placement can create “problems” in your trace 
that actually don’t exist in your sound system.

Primary Mic Position

This is the main reference point for a speaker and can be used 
as a single, “representative” position if you’re short on time or 
patience and just want to get a “gut check” of your system.

Your goal in setting the primary mic position is to find a point that puts 
the microphone in the center (on axis) of a speaker’s throw, within 
the listening area. In other words, you want to put the microphone 
smack dab in the middle of where your speaker sounds its best.

1

Secondary Mic Position

You will use two different secondary positions in a multi-point measurement. These 
can be on- or off-axis measurements of a speaker within the listening area. This will 
allow the SRA wizard to create an average frequency response of your sound system. 
Avoid using locations outside the core coverage area of your system or on the edges. 
The graphic below displays some good secondary measurement positions relative 
to the primary position, as well as some positions that would be more problematic 
than useful. With any mic position, avoid creating position-related anomalies.

1
2

2

2

2

2
2

2
2 2

X

2
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A word of caution about ground bounce: Ground reflections become an 
issue when a speaker is flown and angled down. The proper mic position, 
in this case, will also catch the reflection of the signal off the floor.

Re�ection arrives ~4ms late...

In this case, you can choose from three options:

•• Block the reflection with a baffle that is large enough to 
be effective above 100 Hz (so at least 5’ by 5’).

•• Do a ground-plane measurement.
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•• Do a multi-point measurement. Enough measurement 
positions will randomize the effect of the floor bounce.

4.9.6	 System Alignment Rules

The visual result of a sound-system test can be a powerful tool; 
however, like any powerful tool, you must be responsible about 
how you wield it. Here are few basic principles to follow:

Solve the problem at its source. The closer to the source, the more effective 
the solution will be. If your kick drum lacks punch in the mix, take a look 
at the kick-drum channel’s EQ and dynamics processing. Is the kick drum 
properly tuned? Are you boosting the attack of the kick beater enough 
and at the right frequency? Is your compressor’s attack too long?

Use the right tool. The system EQ is the last in a long line of possible solutions 
to frequency problems. Once you have fully assessed the problem, you 
can choose the right tool. Check the acoustic space, choice of equipment, 
and system design first. Obviously, you don’t always have control over the 
acoustic design or treatment (or lack thereof) of a room, and your wallet 
might determine your choice of speakers more than your needs do, but 
usually you have some control over your sound system’s design.

Can you raise the speakers to mitigate some of the harsher 
reflections? What about widening the stereo field?

After you’ve ruled out physical solutions to a sound problem, move on to level and 
delay. Can you simply lower the level of your subwoofer to kill some of the boom 
in the room? Can you delay your front-of-house speakers by a few milliseconds 
so that they’re in alignment with the guitar cabinets blaring from stage?

If you can’t find a physical solution and can’t mitigate the issue with 
level and delay control, it’s time to employ the system EQ.

A frequency-response trace is not a video game. Your goal is to fix your 
system and make it sound the best it can, not create an EQ curve that is an exact 
inversion of the frequency-response trace. Mix with your ears, not your eyes.

An analyzer is a tool; you are the carpenter. You decide where 
to measure your speakers. You decide what the resulting data 
means. You decide what (if anything) to do about it.



4	 Universal Control-AI and VSL-AI 
4.9	 Smaart System Check Wizards 

StudioLive™ AI Software Library 
Reference Manual

53

4.9.7	 Using the Trace: Spotting the Trend

As discussed in the previous section, many factors can affect the response 
of a sound system: the room, system configuration, electronics, wiring, and 
more. Part of understanding what you see is knowing what you should 
not be seeing—or at least having a basic idea of what to expect. After 
all, you are trying to sculpt the EQ curve of the system into something 
that compliments that sound system’s frequency response.

For example, a small system without a subwoofer can’t reproduce much energy 
below 50 Hz. In fact, this frequency cutoff could be even higher, depending 
on the size of the speaker, its factory tuning, porting, etc. This means that 
if you are analyzing a system that is comprised of two 2-way, 12” powered 
speakers, you should expect your frequency-response trace to drop off 
around 50 Hz or so (depending on the frequency response of your speakers). 
Because of this, boosting low frequencies in this type of system wouldn’t 
achieve much and may introduce more problems than it would solve.

Power User Tip: A subwoofer can significantly change the frequency response of a full-
range system. A 3-way system with a subwoofer will be 6 to 18 dB hotter below 80 to 100 
Hz than a 3-way system without a subwoofer. Keep this in mind when viewing your trace.

Different types of live performances make different demands of a PA system. 
A classical concert has very different needs from a rock concert. Just as you 
wouldn’t mix an evening of Bach quartets the same as an evening of thrash metal, 
you don’t want to tune your PA system the same for both types of events.

A classical concert doesn’t need an exaggerate subwoofer output. The audience 
and performer expect and want a natural reproduction of the music. In contrast, 
systems that are tuned for a rock show will use subwoofers essentially as an 
effect. This is how they achieve those pummeling kick and toms and huge 
bass guitar sound: the system is pre-tuned with more bass response.

In other words, you can stack the deck to be assured of a big FOH mix win. In system 
alignment, this deck stacking is called “trends.” Every genre and performance type 
requires a different type of trend. The sole objective of a system EQ is to smooth 
out the sound system by creating a uniform slope that the system follows. This 
will give your system a more uniform sound and performance, as well as better 
clarity, because your system has been pre-EQ’d to meet the needs of the concert.

Below are some examples of trends for various applications:

Music Concert

Subs

2 to 4 kHz

Rock Concert

Subs

Extended LF
2 to 4 kHz
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Music Playback/Reproduction

Subs

Speech Intelligibility

2 to 4 kHz100 Hz

Power User Tip: The amplitudes depicted in the trend examples shown here are 
guidelines: examples of very general slopes required for different applications. 
The desired value will be different for every gig, and it is ultimately up to you to 
decide what is required for your show, based on what type of artist is performing 
and what kind of sound system you are using. While making a trace follow these 
trends is recommended, in real-world applications, this might not always be 
possible. Being able to compromise and work with what you have often requires 
a certain amount of creativity and artistry on the part of the system engineer.

4.9.7.1	 Spotting the Trend: Real World Example

Let’s take a look at the following frequency-response trace. In this 
example we can see a few peaks that don’t go along with our 
application; for our purposes, let’s make that a music concert.

Our goal is to get from this:

to this:

Subs

2 to 4 kHz

…all the while keeping in mind that we cannot alter the speaker’s 
frequency-response curve, even if we would like to.

Looking at our trace, it’s easy to spot a few problem areas. There’s a 
bump at 300 Hz that could be smoothed out a bit. Another bump 
at 750 Hz could stand some flattening, and a big rise at 1 kHz to 10 
kHz is going to make our system shrill at higher volumes.
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What about all the other bumps and dips? Remember: The frequency-response 
trace is not a video game. You don’t need to put a filter on every bump or dip 
in your trace when a few carefully placed filters will achieve a much better 
result. This is also why the wizard overlays the trace on your parametric EQ.

A parametric EQ is an ideal tool to shape your system’s frequency-response trace into 
a trend that will complement your application. With a parametric EQ, you have the 
ability to process large areas of bandwidth, with minimal electronic smearing to the 
signal. This also frees up your graphic EQ for aesthetic adjustments or fine-tuning.

So, let’s apply the following EQ setting and take a look 
at the resulting frequency-response trace:

As you can see, just four filters made a big difference, and now our system’s 
frequency-response trace follows the general Music Concert trend that we needed.

Music Concert
Trend (no sub)

Power User Tip: Spotting the trend and knowing what to do with it are experiential 
skills that get better over time. Because of this, you may try using the trends in the 
previous section as practice tools. Shoot your room with the SRA wizard and try to 
EQ it for speech intelligibility, then play an audio book or a recording of your favorite 
inspirational speech through your system. Turn the EQ on and off while listening. 
Did you make the system better? Try the same experiment using the Rock Concert 
trend and play your favorite live album through your system this time. Over time, 
you’ll begin to see what really constitutes a problem and what can be overlooked. 
You don’t need to have access to a live venue to do this. Set your speakers up in 
your garage, or living room, or both and try to see the differences in the rooms.
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5	 StudioLive Remote-AI for iPad
StudioLive Remote-AI (SL Remote-AI) for iPad provides an unprecedented 
level of remote control over your StudioLive. With SL Remote-AI, you 
can adjust level, pan, dynamics, bus routing, FX mixes, aux mixes, and 
GEQ settings from an Apple iPad via a wireless network. All you need is 
a Wi-Fi router and an Apple iPad, and you’re ready to get started.

Apple’s iPad offer two viewing options: Landscape and Portrait.

For the most part, you will hold your iPad in Landscape view. This will allow 
you to use the Start, Overview, Aux Mix, GEQ, and Setup pages. Portrait view 
provides you with a zoomed-in look at the currently selected channel and allows 
you to scroll quickly through every channel and bus on your StudioLive. 

To use StudioLive Remote-AI, you must first connect your StudioLive and iPad 
to the same wireless network. See Section 3 for networking instructions.

To launch StudioLive Remote-AI, tap on the SL Remote-AI icon on your iPad. 
When you launch StudioLive Remote-AI, you will be taken to the Start page.

On the Start page, you will see a list of every StudioLive AI mixer on the 
network. The Start page also includes simulations for each of the three 
StudioLive AI mixers so you can practice your finger control away from 
your StudioLive. Tap on the Demo Mixers tab to view this list.

To connect to your mixer, tap on the StudioLive device icon. The 
text will change color to alert you that it has been selected.

Tap the mixer you wish to control from your iPad to open SL Remote-AI.
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5.1	 Overview Page

The Overview page in StudioLive Remote-AI corresponds directly with 
most of the controls on the Overview page in VSL-AI. The following 
parameters can be controlled and/or viewed from this page:

•• Channel and Main Volume

•• Channel and Main Select

•• Channel Mute

•• Channel and Master Metering

•• Channel Panning

•• Channel Digital Return

•• Channel and Main Gate, Compressor, and EQ Overview

•• Channel and Main Gate, Compression, and EQ Zoom

If you have labeled your channels using the Channel Info page 
on your StudioLive or the scribble strip on the Overview tab in 
VSL-AI, you will also be able to see your channel names.

5.1.1	 Bus Assignments Query

Above each channel, you will find the Bus Assignments view. This displays the current 
bus assignments and digital return status for each channel. To engage a particular 
channel’s digital return, or to assign it to a bus, tap on the display.

This will open the Bus Assignments Query page for that channel. Press on the 
Digital Audio icon to activate the digital return. Pressing on a Sub or Main Assign 
button will assign/unassign the channel to that bus. Any change made on this 
page is immediately displayed in the corresponding Bus Assignment Query.

To close the page, press anywhere on the screen.

5.1.2	 Fat Channel Microviews and Zooms

Each channel and bus features a microview of the Fat Channel components. These 
microviews allow you to see whether a particular channel or bus has dynamics 
processing enabled. If any of the dynamics processors in the Fat Channel are turned 
off, its microview will be grayed out. 
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To make changes to the Fat Channel dynamics processing, tap on any of 
the microviews. This will launch the Fat Channel zoomed view, with that 
component in focus; for example, if you tap on the Compressor microview, 
the Fat Channel zoom will open with the Compressor in focus. 

You can switch between the dynamics components in the zoomed Fat 
Channel view by swiping your finger to the left or right. For example, if you 
launch the Gate Zoom and swipe your finger to the left, the Fat Channel Zoom 
will focus on the compressor; swiping to the left again focuses the EQ.

To close the Fat Channel Zoom, tap on the “x” in the upper right-
hand corner. This will display the normal Overview page.

5.1.3	 Channel Controls

Select. Selects Channel for Fat Channel Zoom and Portrait View.

When no microview has been selected for Fat Channel Zoom, the channel Select 
buttons merely display the channel number or name, if one has been entered 
into the scribble strip in VSL-AI or in the Channel Info Page on your StudioLive.

Once Fat Channel Zoom is launched, the channel Select buttons 
become active, and you can use them to select another channel 
so that you can view its zoomed Fat Channel settings.

Pan. Controls the Panning for Each Channel.

To pan a channel, tap and hold anywhere on the Pan control and then slide your 
finger right or left, while maintaining constant contact with the iPad screen. 
These controls correspond directly to those in VSL-AI and on the StudioLive.

Power User Tip: The Pan control supports off-axis movement. Once you 
have pressed a Pan field to select it, you can slide your finger anywhere in the 
screen and make a side-to-side movement to control the pan position.

The pan position is displayed numerically in the Channel Select field 
while the Pan control is being adjusted in SL Remote-AI.

Mute. Controls the Mute for Each Channel.

To mute a channel, tap its Mute button. The Mute button will turn red, indicating that 
the channel has been muted. 

Fader. Controls the Level for Each Channel

To control the volume of a channel, tap the fader and move your finger 
up or down while maintaining constant contact with the iPad screen.

Power User Tip: The fader supports off-axis movement. Once you have 
touched a fader to select it, you can slide your finger anywhere in the 
screen and make an up/down movement to control the fader.

The fader position is displayed numerically in the Channel 
Select field while the fader is being adjusted.

Power User Tip: As with VSL-AI, the fader position set in SL Remote-AI is the level 
that you will hear. To sync the physical faders on your StudioLive with SL Remote-
AI, press the Locate button on your mixer. While in Locate mode, the physical 
faders on your StudioLive will not be active until they cross the current value in SL 
Remote-AI, so you can adjust them without any changes in level. SL Remote-AI 
gives you the option to have Fader Locate mode engage automatically when a 
fader is adjusted remotely. For more information, please see Section 5.5.
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Metering. Displays the Signal Level for Each Channel.

To the left of the fader, you will see the meter for the channel. The meter will follow 
the meter mode selected on the StudioLive or from VSL-AI. The meter mode cannot 
be changed from SL Remote-AI. 
 
 
 
 
 
 
 
 

5.1.4	 Masters Overview and Masters Section Page

In the upper right corner of every page in StudioLive Remote-AI (Overview, Aux 
Mixer, and Main Graphic EQ), you will find the Masters Overview. This displays the 
metering for the subgroups and main bus.

Tapping on the Masters Overview will open the Masters Section page.

The Masters Section page displays the fader and Fat Channel 
Microviews for the mains, subgroups, as well as showing the FX 
bus Mute buttons. These parameters are controlled in the same 
way they are controlled for channels in the Overview page.

From the Masters Section Page, you can also remotely 
control the Tap Tempo function for a delay loaded on either 
the FXC or FXD buses. Tapping on it repeatedly will change 
the Time parameter to match the tempo entered.

Tapping on any of the Fat Channel Microviews will close the 
Masters Section page. The Fat Channel Zoom will open with 
the selected parameter in focus for the selected bus.

To close the Masters Section page, simply tap anywhere outside it. 

5.2	 Aux Mix Page

The Aux Mix page shows the send level for each channel on each Aux and 
FX bus. The Aux Mix page has two zones. The top zone allows you to scroll 
through your Aux and FX buses. The bottom zone allows you to scroll 
through the channel sends for the currently selected aux or FX bus. To 
navigate right or left in either zone, touch anywhere in the upper or lower 
half of the screen and swipe your finger to the left or right. Swiping left 
scrolls the screen to the left. Swiping right scrolls the screen to the right.

From the Aux Mix page, you can control and view the following parameters:

•• Channel Send

•• Pre / Post Position

•• Aux and FX Bus Gate, Compressor, and EQ Overview

•• Aux and FX Bus Gate, Compression, and EQ Zoom

•• Aux Bus GEQs

•• Edit Effects

•• Recall Effects

•• Assign/Unassign Effects
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5.2.1	 Aux Mix Select and Aux Mixing	

To create an aux mix using StudioLive Remote-AI, tap anywhere in the Aux Mix Select 
tab for that aux. The selected Aux Mix tab will be highlighted to alert you that its 
individual channel-send levels will be displayed below.

•• The Gate, Compressor, and EQ microviews function the 
same for auxes as they do for channels and mains.

•• Tap to open the Send Position menu to select Pre1, 
Pre2, or Post fader channel sends.

•• Tap the Mute button to mute the aux bus.

•• Tap the GEQ button to open the GEQ for the selected Aux. 
 

To adjust the send levels for any channel, tap anywhere in its send level and 
move your finger up or down while maintaining constant contact with the iPad 
screen. These send-level displays have been designed to emulate the StudioLive 
Fat Channel meters while in Aux Mix mode, so they should look very familiar!

Power User Tip: The aux sends support off-axis movement. Once you have 
touched a send-level control to select it, you can slide your finger anywhere on 
the screen and make an up/down movement to control the send level.

5.2.2	 Aux GEQ

In each Aux Bus Select tab you will find the GEQ button. Tapping this button will 
open the graphic EQ for that aux. 

GEQ On/Off Button. Turns a Graphic EQ On or Off.

By default, each graphic EQ is turned off. To enable 
a graphic EQ, tap the GEQ On button.

Power User Tip: If you are making adjustments to a graphic EQ, 
and you can’t hear your changes, make sure it is on!

GEQ Flatten Button. Sets All Graphic EQ Band Levels to 0 dB. 

Draw Tool. Allows You to Draw an EQ Curve with Your Finger.

SL Remote-AI provides flexible control over your graphic EQ settings. You 
can control each band individually, or several bands at once, via the sliders, 
or you can simply draw in an EQ curve and fine-tune from there.

To enable EQ-curve drawing, tap the Draw button and slide your finger over the 
graphic EQ bands. Each band’s slider will snap to your finger as you pass over it.

Tap the “x” in the upper right corner to close the Aux GEQ.
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5.2.3	 FX Mix Select and FX Bus Mixing

To create an effects mix using SL Remote-AI, tap anywhere in the FX Mix Select tab 
for that FX bus. The selected FX Mix tab will be highlighted to alert you that its 
individual channel-send levels will be displayed below.

•• The Gate, Compressor, and EQ microviews function the 
same for auxes as they do for channels and mains.

•• Tap on the Send Position menu to select Pre1, Pre2, or Post fader channel sends.

•• Press the Mute button to mute the aux bus. 
 
 
 

To adjust the send levels for any channel, tap anywhere in its send level and 
move your finger up or down, while maintaining constant contact with the iPad 
screen. These send-level displays have been designed to emulate the StudioLive 
Fat Channel meters while in Aux Mix mode, so they should look very familiar!

Power User Tip: The FX sends support off-axis movement. Once you have 
touched a send-level control to select it, you can slide your finger anywhere in 
the screen and make an up/down movement to control the send level.

5.2.4	 FX Edit

From SL Remote-AI, you can load new FX types and adjust their parameters. To edit 
an effect, tap on the Edit button in the FX Select tab. This will launch the FX Editor for 
that effects bus.

To load a new effects type, tap on the Effects Type window, 
and then tap on the new effects type to load it.

To adjust a parameter, simply tap on it and move your finger up or 
down while maintaining constant contact with your iPad.

To close the Effects Editor, tap the “x” in the upper right corner.

SL Remote-AI allows you to remotely control the Tap Tempo function for a delay 
loaded on either the FXC or FXD buses. Tapping on it repeatedly will change the Time 
parameter to match the tempo entered.
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5.3	 GEQ Page

The Main GEQ page provides a focused view for the stereo 
31-band graphic EQ available on the main bus.

GEQ On/Off Button. Turns a Graphic EQ On or Off.

By default, each graphic EQ is turned off. To enable a graphic EQ, tap the GEQ On.

Power User Tip: If you are making adjustments to a graphic EQ, 
and you can’t hear your changes, make sure it is on!

GEQ Flatten Button. Sets All Graphic EQ Band Levels to 0 dB.

To reset a graphic EQ to 0 dB, simply tap its Flatten button. This will return 
each slider to 0 dB so that no frequency band is boosted or attenuated.

GEQ Link Button. Links the Graphic EQ Pair.

By default, the graphic EQ inserted on the main stereo bus is linked 
so that the two mono graphic EQs function as a stereo graphic EQ 
(for instance, if you adjust Band 15 on GEQ2, Band 15 on GEQ1 will be 
adjusted accordingly, and vice versa). To disable this, simply tap the GEQ 
Link button, and each graphic EQ will function independently.

Overview Map. Provides a Reference Point for the Current Bands in View.

The GEQ tab in SL Remote-AI allows you to zoom in and out to 
make fine adjustments. However, all of this zooming in and out 
makes it easy to get lost and forget which bands in the graphic EQ 
you’re adjusting. This is where the Overview Map comes in.

The Overview Map is located in the bottom right corner of the GEQ page. Whether 
you’ve zoomed in on a few bands, or zoomed all the way out so that you can 
see all 31 bands on your iPad, the Overview Map will highlight which bands are 
currently in view and where they are in reference to the rest of the graphic EQ.

Power User Tip: The Overview Map always follows your current position, so if you 
scroll left or right while you are zoomed in, the Overview Map will scroll with you.

Zooming In. Zooms View In to Make Fine Adjustments.

Press the “+” button to zoom in on the GEQ view. Slide your 
finger to the left or right to access additional bands.

Use the Overview Map in the bottom right corner of the GEQ page 
to reference your current position within the 31 bands.

Zooming Out. Zooms View Out.

Press the “-” button to zoom out the GEQ view. If you have not zoomed 
all the way out (so that you don’t have all 31 bands on your screen), you 
can slide your finger to the left or right to access additional bands.

Use the Overview Map in the bottom right corner of the GEQ page 
to reference your current position within the 31 bands.
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Draw Tool. Allows You to Draw an EQ Curve with Your Finger.

SL Remote-AI provides flexible control over your graphic EQ settings. You 
can control each band individually, or several bands at once, via the sliders, 
or you can simply draw in an EQ curve and fine-tune from there.

To enable EQ-curve drawing, tap the Draw button and slide your finger over the 
graphic EQ bands. Each band’s slider will snap to your finger as you pass over it.

5.4	 Scenes Page

The Scenes page allows you to remotely recall scenes that have been stored on your 
StudioLive AI mixer.

Scene List. Displays Stored Scenes

You can use the Scene list to scroll through the scenes you have 
stored on the computer to which you are networked. Tap on a scene 
to select it. A box will be drawn around it, indicating that it is selected 
to load. The scene that is currently loaded will be highlighted.

Load Button. Loads Currently Selected Scene

Once you have selected the scene you would like to load, tap the Load button. 
The scene will be highlighted in the Scene list, indicating that it is active.

Scroll Up/Down. Navigates Up or Down through the Scene List.

Use the Up and Down arrows to navigate through your Scene list one scene at a time. 
 
 

5.5	 Settings Page

The Settings page allows you to set scrolling and metering functions and to 
create custom names for each channel, aux, and subgroup in your mix.

Scroll by Page. Scrolls Through Channels by Page.

When the Scroll by Page option is enabled, the mixer will scroll to through channels 
by entire pages, rather than by individual channels. Turning this option off will 
allow you to scroll over by a single channel and offer more granular control.

Scroll by Page can be enabled/disabled for both the Mixer and Aux pages.

Peak Hold Metering. Displays the Most Recent Signal Peak.

When Peak Hold Metering is enabled, each meter in SL Remote-AI will 
continue to display the most recent signal peak. This allows you to 
keep an eye on the average loudness of each channel’s signal.

Talkback Bus Assignments. Engages/Disengages Talkback Assignments.

Use these switches to remotely engage/disengage the Talkback bus assignments on 
your StudioLive AI mixer. 

Link Channel Faders. Links Channel Faders when Channels are Stereo Linked.

When Link Channel Faders is enabled, stereo-linked channels will no longer have 
individual control over each fader in SL Remote-AI or VSL-AI. This allows you to 
control the volume of a stereo channel pair by moving either channel’s fader.
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Default to Fader Locate. Activates Fader Locate on StudioLive when Fader is  
Moved Remotely.

With the Default to Fader Locate preference enabled, Fader Locate will automatically 
engage when a fader is moved remotely in StudioLive Remote-AI. This preference 
allows you to quickly sync your StudioLive when you return to the board.

Power User Tip: If you are remotely controlling the faders on your StudioLive, 
it is highly recommended that you enable this preference. When Fader Locate 
Mode is activated, the faders on your StudioLive will not be active. By allowing 
this mode to engage automatically, you can easily see what changes have 
been made to your fader mix when you go back to your StudioLive.

Channel Naming. Creates Custom Names for Channels, Auxes, and Subgroups.

To create a custom name for any channel, aux, or subgroup in your mix, 
simply tap on the text field next to it. This will launch the iPad keyboard. After 
you have entered the new name, tap the Done button. The channels’ default 
name will be replaced with its new custom name in SL Remote-AI, VSL-AI, and 
QMix-AI as well as on the Channel Info page on your StudioLive AI mixer.

Note: Channel Naming in SL Remote-AI can be disabled from the System 
Menu on your StudioLive AI-series mixer. If you are unable to change 
channel names from SL Remote-AI, verify your device’s permissions.
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5.6	 Channel Zoom Page

The Channel Zoom page opens automatically when you turn 
your iPad to the Portrait view. This page provides you with a look 
at every controllable parameter for a channel or bus.

Digital Return
Channel Select

Pulldown Bus Assigns
Incremental
Channel Nav

Gate Controls

EQ Controls

Pan

Meter

Fader

Mute Post EQ
& Dyn

Polarity Limiter

Aux/FX Bus
Sends

Compressor 
Controls

HPF Control
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6	 QMix-AI for iPhone and iPod Touch
QMix-AI for iPhone and iPod touch puts each musician’s monitor (aux) mix in his 
or her own hands. With QMix-AI, you can adjust each StudioLive channel’s aux-
send level to taste and can create a group of channels that you simultaneously 
control with the amazing Wheel of Me. All you need is a wireless router and an 
iPhone or iPod touch, and you’re ready to take control of your own destiny.

The iPhone and iPod touch offer two viewing options: Landscape and Portrait.

These two orientations open two different windows. When you hold your iPhone/
iPod touch in Landscape view, the Aux Mix window will open. When you hold 
your iPhone/iPod touch in Portrait view, the Wheel of Me window will open.

To launch QMix-AI, tap on the QMix-AI icon on your iPhone/iPod touch. 
When you launch QMix-AI you will be taken to the Start page.

On the Start page, you will see a list of every StudioLive AI mixer on the 
network. You can also view QMix-AI using Demo Mixer simulations. 
These offline simulations enable you to practice your finger control away 
from your StudioLive.

To connect to your mixer, tap on the StudioLive device icon to open 
QMix-AI and control the mixer from the iPhone/iPod touch. 
 
 
 

6.1	 Aux Mix Page

The Aux Mix page shows the send level for each channel on each aux to which 
your iOS device has access. It corresponds directly to the aux mixes on your 
StudioLive and has been streamlined to show only the send levels. To open 
the Aux Mix page, simply hold your iPhone/iPod touch in Landscape view.

Aux Mix Select. Displays Channel Send Levels to Aux Bus.

To create an aux mix using QMix-AI, tap on the Aux Mix Select tab for 
that aux. The selected Aux Mix tab will be highlighted to alert you 
that its individual channel-send levels will be displayed below.

To navigate right or left, touch anywhere in the Aux tabs and 
swipe your finger to the left or right. Swiping left scrolls the screen 
to the left. Swiping right scrolls the screen to the right.

Note: Your device’s access to aux mixes is determined from your StudioLive AI 
mixer. If you only have access to one aux mix, verify your device’s permissions 
in the System menu on your mixer. See Section 3.5 for details.
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Channel Send Levels. Sets the Channel Send Levels to the Selected Aux Bus.

To adjust the send levels for any channel, tap anywhere in the channel’s level 
control and move your finger up or down while maintaining constant contact 
with the screen. These send-level displays have been designed to emulate the 
StudioLive Fat Channel meters while in Aux Mix mode, so they should look familiar!

To navigate right or left, touch anywhere in the channel sends 
and swipe your finger to the left or right. Swiping left scrolls the 
screen to the left. Swiping right scrolls the screen to right.

To the left of each channel send is a meter that displays the channel’s 
current signal level. Use this meter to determine if a particular channel has 
signal and to see how hot a signal is before you set the send level.

Power User Tip: The aux sends support off-axis movement. Once you have 
touched a send-level control to select it, you can slide your finger anywhere in 
the screen and make an up/down movement to control the send level.

Lock Orientation. Locks Device in the Landscape View.

Enabling the Lock Orientation button will lock your iPhone/iPod touch in 
Landscape view. While this button is enabled, you cannot open the Wheel of Me.

Locking the view will also remove the Start Page button. Until this option is 
disabled, QMix-AI will launch in this view when connected to the current mixer.

Power User Tip: If QMix-AI doesn’t change pages when you change your iPhone 
or iPod touch’s orientation, make sure that Lock Orientation is not enabled.

6.2	 Wheel of Me

QMix-AI’s Wheel of Me provides you with an easy and effective way to control all 
of the channels that contain your voice and instruments. To open the Wheel of 
Me, turn your iPhone/iPod touch to the Portrait view. The Wheel of Me will open 
for the currently selected aux mix, so if you have Aux Mix 3 selected on the Aux 
Mix page, Aux Mix 3 will still be selected when you open the Wheel of Me.

To begin, set up your monitor mix using the Aux Mix page in QMix-AI, 
VSL-AI, or your StudioLive. Once you have your monitor mix dialed in to 
taste, you simply need to identify which channels are yours. After this, 
the Wheel of Me will control the volume of all your channels as a group, 
preserving the volume of each channel relative to the others.

Me Button. Opens the Me Page.

From the Me page, you can identify which channels are yours in any aux mix. 
For example, if you sing backup vocals and play bass, you probably want 
to hear more of those channels, so you would identify those channels as 
“Me.” As a bass player, you might also want the kick-drum level to increase in 
proportion to your bass, in which case identify that channel as “Me” as well.
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Once you’ve identified these channels as your “Me” channels, the Wheel of Me will 
increase or decrease the level of these channels concurrently, allowing you to create 
a DCA group of your most critical channels in your monitor mix. 
 
 
 
 
 
 
 
 
 
 

To return to the Wheel of Me, tap the Aux button in the upper left-hand corner. 
 
 

Wheel of Me. Controls the Level of the Me Channels.

The Wheel of Me increases or decreases the level of your Me channels as a mix 
relative to the rest of the channels (the Band). If you increase the level of your Me 
channels beyond the top level, rather than further raising the Me level, the Band 
channels will decrease in volume, producing the illusion of “even more Me.”

On either side of the Wheel of Me, you will find Me and Band mix indicators. These 
level displays show the balance between the Me channels and the Band channels. 
The Band channels consist of any channels not identified as Me channels. These 
indicators will adjust automatically as you move the Wheel of Me up or down. 

Power User Tip: The “Band” indicator will not show a level until you create 
an aux mix on the Aux Mix page. The “Me” indicator won’t show a level until 
at least one channel is selected on the Me Channels page. If all channels in 
the aux mix are selected on the Me Channels page, level will only be shown 
in the “Me” indicator, and no level will be shown in the “Band” indicator.

Lock Orientation. Locks Device in the Portrait View.

Enabling the Lock Orientation button will lock your iPhone/iPod touch in Portrait 
view. While this button is enabled, you cannot open the Aux Mix page.

Locking the view will also remove the Start Page button. Until this option is 
disabled, QMix-AI will launch in this view connected to the current mixer.

Power User Tip: If QMix-AI doesn’t change pages when you change your iPhone 
or iPod Touch’s orientation, make sure that Lock Orientation is not enabled.
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6.3	 Settings Page

To open the Settings page, tap on the Settings button on the Aux Mix page or Wheel 
of Me page. From the Settings page, you can customize QMix-AI scrolling and 
metering. 

Scroll by Page. Scrolls through Channels by Page.

When the Scroll by Page option is enabled, the mixer will scroll through channels 
by entire pages, rather than by individual channels. Turning this option off will 
allow you to scroll one channel at a time, offering more granular control.

Peak Hold Metering. Displays the Last Signal Peak.

When Peak Hold Metering is enabled, each meter in QMix-AI will 
continue to display the most recent signal peak. This allows you to 
keep an eye on the average loudness of each channel’s signal.
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7	 Capture 2

PreSonus® Capture™ 2 is a multitrack digital-audio recording application designed 
to make recording with StudioLive™ mixers quick and easy. With the look and feel 
of a digital multitrack hard-disk recorder, it is instantly familiar. It uses the same 
high-quality audio engine as PreSonus’ groundbreaking Studio One® DAW, and its 
Session files can be opened directly in Studio One, without conversion or exporting.

Capture 2 was designed exclusively for StudioLive-series mixers, 
allowing instant setup and recording directly from the mixer, with 
no configuration. Just launch Capture 2 and click Record Now. At 
the end of the show, click Stop, save the file, and you’re done!

7.1	 Installation Instructions

7.1.1	 Mac OS X

Installing Capture 2 on Mac® OS X machines is as simple as drag-and-drop.

1.	 Double-click on the Capture .dmg file. 
 
 
 
 
 
 

2.	 Drag the Capture 2 icon to the Applications folder shortcut. 
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3.	 Once Capture has been copied to your hard drive, it is ready to use. Simply 
open your Application folder and double-click on the Capture 2 icon. 
 
 
 

7.1.2	 Windows

The Windows® installer for Capture 2 was designed with easy-to-follow 
onscreen instructions to make the installation process quick and simple.

1.	 When you launch the Capture.exe file, a Welcome screen will launch. If you haven’t 
already done so, close all other open applications before clicking “Next.” 
 
 
 
 

2.	 Before Capture 2 can be installed on your computer, you must first agree to the 
licensing terms. Click “I agree.” 
 
 
 
 

3.	 By default, Capture 2 will install in the Program Files folder on your computer. We 
highly recommend that you do not change this default location. Click “Install.” 
 
 
 
 

4.	 Once Capture 2 has been successfully installed on your computer, click “Finish” to 
exit the install wizard. You’re ready to start recording! 
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7.2	 Start Page

You will be taken to the Start page when Capture 2 is launched. The Start page allows 
you to create a new Session, open a Session stored on your computer, view recent 
Sessions, and verify that your StudioLive is properly communicating with its driver. 
In addition, you can begin recording instantly by clicking the Record Now button.

7.2.1	 Tagging and Organizing a Session

 
At the top of the Start page, you will find the three Name Scheme fields: Artist, 
Performance, and Location. When you enter information into each of these fields, 
your Session will be automatically named with this information, in this order, and 
tagged with the same helpful metadata.

These tags also help to keep your files organized. Rather than throwing 
every Session into a single folder, all tagged Sessions will automatically 
be put into an organized folder hierarchy. By default, Capture 2 inserts 
the date of performance and creates subfolders. These options can 
be changed in the Options menu; see Section 7.2.5 for details.

By default, the folder tree is Artist/Performance/Location. This structure is useful for 
regularly gigging bands that want to archive performances (e.g., Artist: PreSonus 
All Stars, Performance: Winter Tour 2013, Location: Baton Rouge_Manship Theatre). 
However, Capture 2 doesn’t limit you to this folder structure. You can change the 
folder hierarchy from the Options menu. Here are other available Name Schemes:

•• Location/Artist/Performance. This Name Scheme is especially useful 
for venue owners who are archiving the performances on their stage 
(e.g., Location: Manship Theatre/PreSonus All Stars/Winter Tour 2013.

•• Location/Performance/Artist. Use this Name Scheme when recording 
an entire festival (e.g., PreSonuSphere/Stage 1/PreSonus All Stars).

As you archive your performances, Capture 2 stores a history of the names you have 
entered into each field. To use a name again, simply click on the pull-down menu for 
that field and select it from the list. 
 
 

To clear the currently selected name from the list, select Remove First from the 
pull-down menu. 
 
 
 

To remove every name in the list, select Clear History. Once the history has been 
cleared, it cannot be undone, so be certain before you choose this option. 
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7.2.2	 Creating a Session

Below the Name Scheme fields, you will find the New Session button. Click on the 
New Session button to create an empty Session.

Power User Tip: A Session is a Capture file in which you record, arrange, 
and edit your audio files. Session files should not be confused with audio 
files. Think of a Capture Session as you would a StudioLive scene. It is a 
snapshot of which audio files were recorded and how they were edited.

You can also create a new Session by doing one of the following:

•• Navigate to File/New Session. 
 
 
 
 
 
 
 

•• Press [Ctrl]/[Cmd]+N on the keyboard.

If you have filled in the Name Scheme fields, your 
new Session will launch automatically.

If you have not filled in these fields, a setup menu will open.

•• Session Title. This will be the title of your Session and will be the Session filename, 
as well as the name of the new folder that contains all data related to your Session.

•• Session Location. This is where new Sessions and all related data will be saved. 
The Session location can be chosen each time you create a Session. By default, 
the new Session location will be the Capture 2 folder in your Documents folder.
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You can choose a different file location by clicking on the Browse button and 
browsing to a new location. The last known save location will appear as the default 
the next time you create a new Session.

Power User Tip: The Name Scheme fields have been added to Capture 2 
to help keep your Sessions organized and to make your archived library 
of live performances more easily searchable. Because of this, we highly 
recommend that you always take a moment to fill in these fields.

Record Now! Clicking the Record Now button on the Start page will launch a new 
Session, arm all tracks for recording, and begin recording immediately. If you do not 
have any of the Name Scheme fields customized, your Session will be labeled with 
today’s date. 
 

7.2.3	 Open a Session

The Capture 2 Start page provides two different 
ways to quickly open previous Sessions. 

Open Session Button

Clicking on the Open Session button will open a browser that will allow you to 
browse for, and open, an existing Session. 
 

Recent Files List

Located below the Open Session button, you will find the Recent 
Files list. This list includes links to the most recently opened 
documents. Click on any of these links to quickly open the Session. 
 
 
 
 
 

Locate Missing Files

In the event that the Session you open is missing audio files, Capture will 
help you find them. Use Session>Locate Missing Files to search your 
computer for lost resources. 
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7.2.4	 Audio Device, Networking, and Sample Rate

Audio Device and Sample Rate

Capture 2 was created for use with PreSonus StudioLive-series mixers and 
fully functions only with them. The Audio Device menu displays the currently 
selected audio driver. When a StudioLive is connected to your computer 
via FireWire, you should select “PreSonus” from the Audio Device list. 

Power User Tip: If the currently selected audio device has exactly two outputs (as 
with the built-in audio card in a Mac), Capture goes into Stereo mode. While in Stereo 
mode, Capture connects all tracks to the stereo output and adjusts the volume of 
the output automatically to account for stereo summing. Stereo mode enables 
you to listen to Sessions while away from your StudioLive. Unless the StudioLive’s 
driver is selected, you cannot create a new Session or record new audio.

 
While in Stereo mode, a level control appears at the top of the track list in Capture so 
that you can adjust the level of the stereo mix.

Sample Rate. The Sample Rate menu displays the currently configured 
sample rate. Note: Your StudioLive AI mixer is the master clock. You 
must set the sample rate on your mixer rather than inside of the 
application. See Section 5.5 in the StudioLive AI Mixers Owner’s Manual 
for more information on setting the sample rate on your mixer.

Networking 

Like VSL-AI, Capture can communicate with your StudioLive AI-series mixer over 
a wireless or wired LAN network. Networking Capture with your StudioLive AI 
mixer allows you to remotely store and recall scenes from Capture; read and 
write channel labels between Capture, VSL-AI, and the StudioLive Channel Info 
page; and remotely enable digital returns for a quick virtual soundcheck. 

Once you have connected your computer to your StudioLive 
network following the instructions in Section 3.2, you must connect 
Capture to the same network by doing the following:

1.	 Click on the link below the Audio Device menu to scan the network for available 
StudioLive mixers. 

2.	 This will open the network browser and allow you to connect to your 
StudioLive mixer so that you can control it from Capture. If you do not 
want Capture to remote control your mixer, select “None.” 
 
 
 
 
 

3.	 After you have selected your StudioLive mixer, click “ok.” 
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You will then see your StudioLive listed at the bottom of the Start 
page, and the icon will show your StudioLive AI mixer.

Power User Tip: You can also control your StudioLive AI mixer 
over FireWire by launching Universal Control-AI and running it in 
the background. VSL-AI does not need to be launched.

7.2.5	 Options Menu

The Options button can be found just above the bottom of the Start page. This 
launches the Options menu. 
 
 

•• This menu can also be accessed from Capture>Options.

•• The Options menu can also be accessed by clicking on 
the Options button on the Session page.

The Options menu provides all the tools necessary 
to configure your Session preferences.

Audio Options

•• Audio Device. At the top of the Audio Options, you will find 
the Audio Device menu. This is the same menu that is on 
the Start page. See Section 7.2.4 for information.

•• Device Block Size. This displays the buffer size. In general, the higher the 
buffer size is set, the more stable your recording environment will be.

•• Sample Rate. The Sample Rate menu is also found on the 
Start page. See Section 7.2.4 for information.

•• Record Format. The Record Format menu allows you to 
choose the bit-depth of the recorded audio. You can select 
16-bit WAV, 24-bit WAV, or 32-bit floating-point WAV. 

Power User Tip: The higher the bit-depth of your audio, the better its resolution, and 
the bigger the resulting file size will be. In general, we recommend recording at 24-bit.

•• Pre-Record. Capture 2 allows you to set a Pre-Record buffer. This 
buffer starts recording audio before your click the Record button so 
you won’t miss the beginning of a performance. The Pre-Record buffer 
time is user-selectable, between five seconds and one minute.
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Power User Tip: The higher the Pre-Record buffer is set, the more RAM Capture 2 will 
require. For example, a 32-track recording with a Pre-Record buffer of 1 minute will 
require approximately 800 MB more RAM than the same recording set with a buffer of 
5 seconds. While this will not cause problems on modern systems that are equipped 
with copious amounts of RAM, we highly recommend that the Pre-Record buffer be 
set as low as possible on systems with the minimum amount of required RAM (2 GB).

Timeline Sync Options

•• Timeline Sync Mode. Capture 2 features a Timeline Sync mode. This 
allows you to align the timeline in your recording Session to the time of 
day or to sync it to an external MIDI Time Code signal. This will also affect 
the timestamp information, which is written into the audio files.

•• No sync. The timeline will start at 0 and will display the length of 
your recording (in minutes and seconds only). This option is useful 
when you only want to track the length of your recording.

•• Sync to computer time. The timeline ruler will start at the exact time of 
day the recording began. This option is useful when recording multiple 
performances over the course of a day (e.g., at a festival stage).

•• Sync to MTC. Capture will align the timeline to incoming MIDI Time 
Code. This option is useful when recording audio for a live video.

•• MIDI Time Code Input. To use the Sync to MTC option, you must provide Capture 
with an input for the source time code. You can select that source from this menu.

File Handling Options

As discussed in Section 7.2.1, Capture 2 provides an assortment 
of useful tools to organize and label Capture Sessions.

•• Storage Location. By default, all Capture Sessions are stored in the 
Capture subfolder in your Documents folder. You can set a new default 
location by clicking on the “Change…” link. This will launch a browser 
window, allowing you to find a new location for your Capture Sessions.

•• Name Scheme. Section 7.2.1 discusses the various options 
for naming and organizing your files. This option enables you 
to select the order in which your files are categorized.

•• Create Subfolders. Clicking the Create Subfolders options will 
create a folder for each of the three naming conventions: Artist, 
Performance, and Location. If this box is not checked, your Session 
and the resulting audio files will still be labeled using these tags but a 
folder hierarchy will not be created. This box is enabled by default.

•• Add Date to Path. By default, Capture automatically adds the date of the Session 
to the Session name. You can remove the date by unchecking this option.

•• Load StudioLive Mix Scene with Capture Session. By default, Capture will 
automatically load a stored StudioLive AI mix scene when opening a Capture 
session that has had a scene stored with it. You can disable this feature by 
unchecking the box. The feature is only available with AI-series StudioLive mixers.
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7.3	 The Session Page

Capture 2 features a single-window user interface so you don’t need to 
manage multiple windows and views. When a new Session is created, or an 
existing Session is opened, you will be taken to the Session page. This page 
contains all of the necessary tools to record and edit multitrack audio.

Capture 2 takes full advantage of the StudioLive’s bidirectional FireWire bus 
and hardwired configuration. When you launch Capture 2, a recording track 
is created for each input channel on your StudioLive. That track, in turn, is 
automatically patched to the corresponding digital return on your StudioLive AI 
mixer for playback. The following diagrams show this one-to-one relationship.

Capture 2 Recording Routing

Capture 2 Playback Routing

There is no need to set up audio inputs and outputs in Capture 2, as the 
software automatically detects which StudioLive model is connected 
and auto-configures for it. Each input from the StudioLive AI mixer 
is represented with a mono input track in the Track column of the 
Session and has a corresponding level meter in the meter bridge.

An additional stereo track will also be added to the Session for recording 
the first pair of auxiliary inputs (Inputs 33-34/25-26/17-18).

Save

Undo
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7.3.1	 Track Column

Along the left side of the Session page, you will find the Track column. The Track 
column contains a dedicated audio track for each audio input into Capture 2 from 
the StudioLive AI mixer, including a stereo track to record any of the auxiliary digital 
sends (see Section 2.5.4), and provides the following essential functions: 
 
 
  
 
 

Track Naming.

To name a track, double-click on the default name to open a text-
edit box. Enter the name you would like to use and hit Enter.

There are several benefits to giving each track in your Session a name. First, 
it allows you to know at a glance what is being recording where. Second, if 
you name your tracks before you begin recording, the audio file recorded 
on your named track will be given the same name. So, for example, instead 
of a bass line being recorded as Track 15, it would be recorded as Bass.

Power User Tip: As with VSL-AI and Studio One, you can press 
the Tab key to move to the next track’s name field.

Sync Names (StudioLive AI-series mixers only).

At the top of the Track column, you will find the Sync Names button. This feature is 
enabled by default and synchronizes the names for each track in Capture with the 
channel names in VSL-AI and in the Channel Info page on your StudioLive AI-series 
mixer. While this feature is active, you can name your channels from your mixer, 
VSL-AI, or Capture, and all three will update instantly.

If you engage Sync Names in the middle of a Capture session, 
you will be asked whether you want to load the channel names 
from Capture or from your StudioLive AI mixer.

Arm All.

In the upper left-hand corner, you will find the Arm All button. Click this button to 
arm (enable) all inputs for recording. 

Engage Digital Returns (StudioLive AI-series mixers only).

When you are ready to listen back to your Capture recording, click on  
Engage Digital Returns to remotely enable every Digital Return button on your 
StudioLive AI-series mixer.
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Track Controls.

Each track in the Track column features the same controls. 

Power User Tip: The track number to the left of each track in the list corresponds 
directly to the same channel number on your StudioLive AI mixer.

•• Record Arm Button. Next to each track number is the Record Arm button. When 
this button is active, Capture 2 is ready to record audio that is routed to the track.

•• Track Mute. Each track features a Mute button. 
This mutes the track during playback.

•• Track Solo. Each track features a Solo button. This will solo the track and mute 
all other tracks during playback (similar to the SIP function on the StudioLive).

7.3.2	 Transport

The Transport is located in the top left corner of the 
Session page. It contains all the functions you need to 
navigate through your Session. 
 
 

•• Stop. Stops playback. 
 

•• Play. Starts playback at the current playback-cursor position. 
 

•• Record. Starts recording at the current playback-cursor position. 
 

•• Record Lock. The Record Lock button prevents the recording from accidentally 
being stopped by an errant press of the space bar. Record Lock is automatically 
enabled when Capture starts recording. It can be defeated by simply clicking on it.

Power User Tip: Markers can still be edited and dropped while Session Lock is enabled. 

•• Return to Zero. Returns the playback cursor to the beginning of the Session.

•• Previous Marker. Jumps the playback cursor to the previous marker.

•• Rewind. Rewinds as long as this button is enabled.

•• Fast Forward. Fast-forwards as long as this button is enabled.

•• Next Marker. Jumps the playback cursor to the next marker.

•• Go To End. Jumps the playback cursor to the end of the recorded audio.

•• Loop. Engages/disengages Loop mode. See Section 7.3.6 for more information.
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7.3.3	 Time Display

The Time Display provides you with critical information about your recording.

•• Session Name. Displays the name of the current Session.

•• Record Duration. Displays how long the current Session has been recording.

•• Cursor Time. Displays the current timeline position of the playback cursor.

•• Remaining Time. Displays the remaining time that can be recorded, based on 
the size of the available storage left on the hard drive to which you are recording.

7.3.4	 Timeline Ruler

At the top of the Session Editor, you will find the Timeline 
Ruler. This displays time increments in seconds.

As mentioned in Section 7.2.5, you can set the Timeline Ruler to sync to 
your computer’s clock or to an external MIDI Time Code source.

7.3.5	 Navigating the Session

Zooming

You can zoom in and out of your Session, with respect to time, in the Session 
Edit window, so that you can look at the entire length of the Session or 
just view a small region of time to make accurate edits. You can also zoom 
in and out with respect to the size of the audio files in your Session.

To zoom in and out of the timeline, do one of the following:

•• Click-and-drag left or right on the Horizontal Zoom scroll bar in the lower right-
hand corner of the Edit window.

•• Press [Ctrl]/[Cmd]+[+] on the keyboard to zoom in slightly. Press 
[Ctrl]/[Cmd]+[-] on the keyboard to zoom out slightly.

•• Click inside the Timeline Ruler at any point in time and drag down or up.

To resize the height of the tracks and their corresponding audio file, use the Vertical-
Zoom control in the lower left-hand corner of the Edit window. 
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Scrolling

To scroll left and right through time in your Session, click-and-drag 
the horizontal scroll bar near the bottom of the Edit window.

You can also scroll through your Session by clicking and 
dragging the Timeline Ruler left or right.

Locate Selection

To jump the playback cursor to the beginning of any audio event, 
press L on the keyboard or select Session>Locate Selection.

7.3.6	 Editing Tools

In the upper right corner, you will see four editing-tool buttons. These 
tools will determine the function of your mouse during editing.

Power User Tip: The audio-editing process can be unforgiving. Small inaccuracies when 
splitting, moving, or performing other actions on recorded audio can lead to unwanted 
results. As simple as it may seem, the act of listening while editing is often overlooked. 
For instance, when sizing the edges of a vocal part to remove unwanted sounds 
between words, it is tempting to make the edits based on the visual representation of 
the waveform. While this may work sometimes, it is much better to listen as you size 
the events to be sure you are not removing any critical part of the vocals. Listening 
to your edits as you make them will save time and frustration in nearly every case.

7.3.6.1	 Arrow Tool

This is the default tool for access to most functions. Click on the Arrow tool button or 
press [number 1] on the keyboard to select the Arrow tool.

The Arrow tool can be used for the following purposes:
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Move an Event.

To move an audio event using the Arrow tool, click anywhere on the event and 
drag left, right, up, or down. Dragging the event left or right will move the event 
backward or forward in time. When dragging an event left or right beyond the 
viewable arrangement, hold [Space Bar] on the keyboard to speed up the scrolling.

Dragging the event up or down will move the event to another track. 
When dragging an event from one track to another (up or down), the 
position of the event will be constrained within an automatic snapping 
range to make it easy to keep the event at the same time position. To 
defeat this snapping, hold Shift while dragging the event up or down.

Rearrange Tracks.

To rearrange tracks using the Arrow tool, click on the track you want to move and 
drag up or down in the Tracks list. You will notice a blue line following your mouse. 
When you drop the track, it will be inserted where the blue line is located.
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Size an Event.

Events can be thought of as windows into audio files and musical performances, 
where what you see is what you hear. You can resize events to make them shorter 
or longer so that only a portion of the audio or musical data is seen and heard.

To size any event using the Arrow tool, float the mouse to the left or right edge of the 
event to reveal the Sizing tool. When this tool appears, click-and-drag left or right to 
size the event. Events can be sized and resized nondestructively any number of times.

Select Multiple Events. 

Multiple events can be selected in order to edit them all at once, with a single 
action. To select multiple events with the Arrow tool, do one of the following:

•• Click outside of the range of an event and then drag over any other 
events; a gray box will be drawn while you drag over the target-selection 
area. Release the mouse button once the box is drawn over all of the 
events you wish to edit, and these events will be selected for editing.

•• Click on any event; then, while holding [Shift] on the keyboard, click on any other 
events to select them. This allows you to select multiple events that are not in 
close proximity to each other. All selected events can then be edited at once.

7.3.6.2	 Range Tool

The Range tool is used to select a range, or area, within events. Click on the Range 
tool button or press [number 2] on the keyboard to select the Range tool.

To select a range within an event, using the Range tool, click-and-drag over the area 
to be selected; a gray box will be drawn over the target selection area. Release the 
mouse button when the box is drawn over the range of the events you wish to select. 
The range you have selected will then be treated as a single, consolidated event.



7	 Capture 2 
7.3	 The Session Page

StudioLive™ AI Software Library 
Reference Manual

85

The Range tool can be useful in several ways:

•• You can use the Range tool to select the content of several audio events 
across multiple tracks for a specific portion of a song (say, an amazing 
drum groove) and then use the Arrow tool to move that section of 
audio to another section of a song (say, to replace a drum groove).

•• Another common use of the Range tool is to quickly select and delete a 
range of audio within an event, rather than using the Split tool to make 
two splits, then select and delete the section with the Arrow tool.

Power User Tip: When you float the mouse cursor over a selected range, the Arrow tool 
will temporarily appear. This makes it easy to quickly select and edit a range of events.

To select multiple, discontiguous ranges across any event, on any track, 
hold the [Shift] key while using the Range tool. Continue to hold [Shift] and 
use the Arrow tool to select whole events. For instance, when using the 
Arrow tool, if you press and hold [Ctrl]/[Cmd], you get the Range tool. Press 
and hold [Ctrl]/[Cmd] and [Shift] to select multiple ranges, then continue 
to hold [Shift] but release [Ctrl]/[Cmd]; now you have the Arrow tool and 
can select whole events. All of your selections will remain selected.

Selected ranges can be sized by floating the Range tool at the left/
right edge of the selection. You also can split a selected range at the left 
and right edges of the selection by choosing Split Range from the Edit 
menu or by pressing [Ctrl]/[Cmd]+[Alt]+[X] after selecting a range.

7.3.6.3	 Split Tool

Using the Split tool, single events can be split into multiple events. Click on the Split 
Tool button or press [number 3] on the keyboard to select the Split tool.

With the Split tool selected, a vertical and horizontal line will be drawn near the 
current mouse-cursor position. The vertical line indicates the exact time position 
of the Split tool, while the horizontal line underscores the track on which the event 
to be split resides. The Split tool is directly affected by the current Snap settings.

Click on any event with the Split tool to split the event at that position. 
By splitting a single event, you create two events that can be edited 
independently. If multiple events are selected across multiple tracks, 
the Split tool will affect all of the selected events in the same way.

It is also possible to split selected events at the timeline cursor, without 
using the Split tool, by pressing [Alt]+[X] on the keyboard.

7.3.6.4	 Eraser Tool

The Eraser tool is used to delete an event. Click on the Eraser Tool button or press 
[number 4] on the keyboard to select the Eraser tool. To delete any event using the 
Eraser tool, simply click on the event. The Eraser tool is unaffected by the current 
selection and will only affect the event that is directly clicked on.

However, if you click on a selected event with the Eraser 
tool, all currently selected events will be erased.
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7.3.6.5	 Common Editing Actions

Like most software applications, Capture 2 supports basic cut, 
copy, and paste actions. Once you’ve selected an event, or a range 
of events, you can perform these actions as follows:

•• Cut: Press [Ctrl]/[Cmd]+X on the keyboard to cut 
the current selection or select Edit>Cut.

•• Copy: Press [Ctrl]/[Cmd]+C on the keyboard to copy 
the current selection or select Edit>Copy.

•• Paste: Once a selection is cut or copied, press [Ctrl]/[Cmd]+V on the keyboard 
to paste the selection or select Edit>Paste. The selection will be pasted to the 
current playback-cursor position, or to the beginning of the track from which 
the selection originated if the playback cursor is not currently set anywhere.

7.3.6.6	 Looping

To loop the playback of any range in your Capture 2 Session, do one of the following:

•• Loop Selection. Select an event with the Arrow tool or select a range with 
the Range tool. Go to Session>Loop Selection or press P on your keyboard. 
This will create a loop the exact length of the selected audio event. The range 
will be indicated by a bar drawn in the timeline, with flags at both ends.

•• Custom Loop Range. To create a custom loop range, mouse over 
the gray line above the timeline ruler. Notice that your cursor 
changes to a Pencil tool, and you can draw your loop range. 

Once your loop range is set, you can click on the Loop button in the transport, or 
press [/] on the keyboard, to engage Loop mode.

Note: Engaging Record in the transport will disable Loop mode and will begin recording 
at the current playback-cursor position. It is not possible to engage Loop while recording.
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7.3.6.7	 Bounce Selection

Once you have edited an audio file, you may wish to create a new audio file 
that includes all of your edits. To do this, use the Range tool to select the 
events you would like to merge as described in Section 7.3.6.2 and press 
[Ctrl]/[Cmd]+[B] on the keyboard or go to Edit>Bounce Selection.

7.3.7	 Meter Bridge

Capture 2 provides input and output metering when a track is being recorded or 
played back. These peak-style meters at the bottom of the Session page feature 
clip indicators for each input into Capture 2 from the StudioLive AI mixer. 

Record Arm.

Below each meter, you will find another Record Arm button. This button provides 
the same functionality as the Record Arm button in the Track column. See Section 
7.3.1 for more information.

Link Button.

Between each meter is a Link button. When this button is active, Capture 2 will 
record that track as a stereo-interleaved file. By default, the routable bus pair (33-
34/25-26/17-18) is link-enabled.

Power User Tip: Linking channels in Capture will automatically link 
those channels on your StudioLive AI mixer and vice versa.

Big Meter Mode.

The Big Meter Mode button is located in the upper right 
corner of the Session page, above the editing tools.
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When this button is engaged, the lower three-quarters of the Session page 
will display detailed metering for every track. While in this mode, the Marker 
Lane, transport, mode buttons, and editing tools will still be visible.

7.3.8	 Markers and the Marker List

The Marker Lane.

The Marker Lane is located just below the Timeline Ruler. 
It displays any markers you have created.

In Capture 2, the Marker Lane is used to place markers at desired 
places in the timeline, after which navigation to the markers is easy. 
Markers are also helpful when exporting your Session to individual 
mixes or for editing in another recording application.

Power User Tip: We highly recommend that markers be inserted during the recording of a 
live performance, as the markers will make the rest of the production process much easier.

The Marker List.

The Marker List button is located above the editing tools on the right side 
of the Session page. Clicking on the button will open the Marker List, which 
provides an overview of every marker in your Session and offers an easier 
way to quickly name markers and move them around your Session.

7.3.8.1	 Inserting, Naming, Deleting, and Moving Markers

Marker Lane.

Adding/Deleting Markers. At the top of the Track column, you will see the Add/
Remove Marker buttons. To insert a new marker into the Marker Lane, with playback 
running or stopped, click on the Add Marker (+) button, or press [Insert] on the 
keyboard. Each new marker will be numbered sequentially by default (#1, #2, #3, etc).

Select a marker and click on the Remove Marker (-) button to remove the marker.
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Naming Markers. To rename a marker, double-click on the marker in the Marker 
Lane, type in a new name, and then press [Enter] on the keyboard. 
 
 

Moving Markers. To move a marker, click on it in the Marker Lane and drag it to the 
desired location. 
 
 
 

Marker List.

At the bottom of the Marker List, you will find three buttons:

Adding Markers. Click on Add Marker to add a marker 
at the current playback-cursor position. 

When a Marker is added to the Marker List, the Name field 
automatically becomes editable. Enter a new name and hit Enter. 
This name can be edited later by double-clicking on it.

Moving Markers. Clicking on the Move Marker button will move the currently 
selected marker in the Marker List to the current playback position in the timeline.

Deleting Markers. To remove a marker, select it in the 
Marker List and click on the Delete Marker button.

7.3.8.2	 Navigating Markers

It is possible to quickly jump the playback cursor between markers in 
the Marker Lane. Jumping to markers during playback allows quick 
comparisons between different sections of your Session.

To navigate to a previous marker, do one of the following:

•• Click on the Previous Marker button in the transport.

•• Press [B] on the keyboard to jump to the previous marker.

To navigate to the next marker, do one of the following:

•• Click on the Next Marker button in the transport.

•• Press [N] on the keyboard to jump to the next marker.

To jump to any marker in your Session, open the Marker List and click on the 
Location field. The playback cursor will jump to this location in the timeline.
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7.4	 Recording a Session in Capture

Setting Input Levels. Setting the proper input level is critical to making a good 
live mix and a good recording. The basic idea is to set the input gain on the 
StudioLive AI mixer as high as possible without overloading the input. Overloading 
the input will cause clipping (digital distortion), which is particularly unpleasant 
and will ruin the recording. This damage cannot be undone in software. There 
is a clip indicator for each input on the StudioLive AI mixer for this purpose.

If an input channel is not clipping on your StudioLive AI mixer, you can be 
sure that it will not clip in Capture 2. Refer to Section 2.1 in your StudioLive 
Hardware Owner’s Manual for the proper level-setting procedure.

You will monitor live audio input on the StudioLive AI mixer; there is no separate 
monitoring capability within Capture 2. Refer to Section 4.4.5 in the StudioLive 
Hardware Owner’s Manual for information on creating monitor mixes.

The Auxiliary Stereo Track in Capture 2 is intended to be used to record a stereo 
mix from your StudioLive. This mix can be recorded while recording the individual 
input channels so that a mix is available immediately after a live show, or you 
can use this track to route your final studio mixes through the StudioLive.

As discussed in Section 4.8.1, VSL-AI features an Auxiliary Inputs Router that 
allows you select which buses you want to record in addition to your input 
channels. The last two tracks in Capture are dedicated for recording a stereo 
mix in Capture 2. In addition to the Main L/R mix, you can select from any pair 
of the following outputs, buses, and inputs: Subgroups 1-4, Auxes 1-14/10/6, 
FXA-D Send Mixes, Aux Inputs A and B, Tape In, Solo Bus, and Talkback.

Arming Tracks. To record to an audio track, the track must be record-enabled, or 
“armed.” Capture 2 provides two Record Enable buttons for each input: one on the 
track and on the meter bridge. Once an audio track is record enabled, you are ready 
to record audio to that track.

Hit Record! To activate recording, click on the Record button in the transport. The 
Record button will turn red, and the Play button will turn green. The playback cursor 
will start to scroll from left to right from its current position, and new audio events 
will be recorded to record-enabled tracks.

Recording will continue until you manually stop it by clicking on the Stop button in 
the Transport or press [Spacebar] on the keyboard. 

When you press Record, the Session automatically locks. This prevents you from 
accidentally stopping recording Session. You must disable Session Lock before you 
can stop recording.

7.5	 Virtual Soundcheck

We’ve all been there. The drummer is stuck in traffic. The guitarist is stuck at work. 
And you’re stuck at front-of-house (FOH) with a hyped up lead singer and bass player 
and no way to dial in a front-of-house mix, let alone set up the singer’s in-ear mix.

Don’t panic!  With Capture 2’s Virtual Soundcheck mode, dialing a good rough 
mix without the band—or with half the band missing—is quick and simple.

1.	 To begin, create a new Session, preferably metatagged with the Artist, 
Performance, and Location information. 
 
 



7	 Capture 2 
7.5	 Virtual Soundcheck

StudioLive™ AI Software Library 
Reference Manual

91

2.	 From your empty Session, click on the Soundcheck Mode 
button in the upper right corner of the Session page.

3.	 Capture will automatically search your computer for Sessions and will open 
a list from which you can choose a Session to use for virtual soundcheck. 

Power User Tip: Sessions that match the metadata tags entered on the Start 
page will be listed first. For example: if you created a new session with an Artist 
tag of “PreSonus,” other sessions with the same Artist tag will be listed first.

Sessions that have a StudioLive AI mix scene stored with them will have a mixer icon 
next to the session’s information.

4.	 Select the Session you would like to use and click “OK.”

5.	 The saved Capture Session will open and all the Digital Return buttons on your 
StudioLive will engage. If you have loaded a session that has a StudioLive AI 
mix scene saved with it, you will be asked if you want to load that as well.

6.	 Press Play in Capture and dial in your mix on your StudioLive. 
 

7.	 When you have finished setting up your mix, click the 
Virtual Soundcheck Mode button again to exit.
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8.	 The track labels from the soundcheck Session are automatically 
loaded into your blank recording Session.

Power User Tip:  If you have Sync Names engaged, all your track names will be 
broadcast to your StudioLive AI mixer, VSL-AI, SL Remote-AI, and QMix-AI.

7.6	 Saving and Loading StudioLive AI Mix Scenes

In Capture 2.1 and later, you have the option of saving your StudioLive 
AI mix scene with your Capture session. This helps keep your audio 
recordings organized; makes doing a virtual soundcheck even easier with 
Capture, as was illustrated in the previous section; and allows you to load 
your StudioLive mix scene into the Studio One mixer when you open a 
Capture session in Studio One (see Section 8.6 for more information)

Save Mix Scene. To save your StudioLive mix scene with your Capture session, click 
on the Save Mix Scene button. This will store the current state of your StudioLive AI 
mixer with your Capture session. 

Load Mix Scene. To load the stored StudioLive mix scene from Capture, click on the 
Load Mix Scene button. This will load the stored scene using the Recalling Filters that 
are enabled on your mixer. For more information on setting Recalling Filters, see 
Section 5.3.4 in the StudioLive AI Hardware User Manual.

Note: This feature is only available if you have stored a scene 
with your Capture session and you have networked your mixer to 
Capture either through FireWire or over a LAN network.

7.7	 Importing and Exporting Audio Files

7.7.1	 Importing Audio Files into Capture

It is possible to import WAV and AIFF audio files into your Session.

1.	 To import an audio file, select Import Audio File from the Session menu, 
or [Ctrl]/[Cmd]+I on the keyboard, to open the Import File menu.

2.	 Browse to the desired file and click on it to select it.
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3.	 Click on Open to import the file into your Session.

4.	 An audio event for the imported file will be created and placed on the currently 
selected track in your Session, at the current playback-cursor position.

Power User Tip: When browsing for files in the Import File menu, it is possible to 
listen to the audio files in the Preview Player. Click the Play button in the Preview 
Player to play the currently selected audio file. Click the Stop button to stop playback. 
Click the Loop button to loop the playback of the currently selected audio file.

7.7.2	 Export Audio Files

To export audio from your Session in Capture 2, navigate to Session/Export Tracks 
or press [Ctrl]/[Cmd]+E on the keyboard to open the Export Tracks menu.

Location.

In the top section of the Export Tracks menu, select 
a location and name for the audio file.

Click on the Browse button to choose a file location.

Double-click on the filename, type in a new name, and press Enter to choose 
a name for the file. Each file that is exported will begin with the filename 
you enter, followed by the name of the track from which it was exported 
and the first marker of the marker pair (if applicable). Examples: “French 
Quarter Fest 2012 _ Kick” or “French Quarter Fest 2012 _ Kick _ Chorus.”



7	 Capture 2 
7.8	 Mixing Your Capture Sessions

StudioLive™ AI Software Library 
Reference Manual

94

Format.

In the middle section of the Export to Audio File menu, select 
the format of the mixdown audio file. Choose from WAV or AIFF 
and choose the desired resolution and sample rate.

If you wish to put your audio on a standard audio CD, the format should 
be a WAV file with 16-bit resolution and a 44.1 kHz sample rate.

Options.

The bottom section of the Export to Audio File menu has 
several options that will affect how files are created:

•• Export Session will export the entire range of your Session to the 
furthest point in time that any audio event on a track extends.

•• Export Each Marker will export separate files for each 
range between the markers in the Marker Lane.

•• Export Between Selected Markers will export audio files between 
the ranges of any two selected markers in the Marker Lane.

7.8	 Mixing Your Capture Sessions

7.8.1	 Creating a Mix in Capture 2

You can’t mix directly in Capture 2; instead, you mix with the StudioLive. The 
individual outputs of each audio track in Capture 2 are hardwired to the digital 
returns for each corresponding input channel on the StudioLive AI mixer. 
With the digital returns engaged for each input channel on your StudioLive 
AI mixer, the output of your multitrack Capture 2 Session is routed to the 
StudioLive AI mixer, where it can be mixed just like any other audio input.

The process of creating a mix with Capture 2 and the StudioLive AI 
mixer is quite simple. Play back your recorded tracks through the 
StudioLive and record the main output of the StudioLive to the 
Auxiliary Stereo Track in Capture 2. The process works as follows:

1.	 In VSL-AI, select “Main L/R” for Auxiliary Inputs 33-34/25-26/17-18.

2.	 Disable Record Arm on audio-input tracks in Capture. 
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3.	 Enable all the digital returns on your StudioLive AI mixer. 

4.	  In Capture 2, select the Auxiliary Stereo Track and arm it to record.

5.	 Bring the playback-cursor position to the beginning of the Session by clicking the 
Return to Zero button in the transport. 

6.	 Activate recording by clicking on the Record button in the transport; the playback 
cursor will begin to move from left to right, and audio will play through each input 
on the StudioLive AI mixer. The Auxiliary Stereo Track in Capture 2 will record a new 
audio event, which is the main mix from the StudioLive AI mixer.

The new audio event that has been recorded from the StudioLive AI mixer will be 
stored as a stereo WAV file at the sample rate to which the StudioLive AI mixer is set.

7.8.2	 Exporting Your Final Mix to an Audio File

The most common physical medium on which recordings are published 
is the audio CD. In order to put your final mix on an audio CD, the mix file 
must be a 16-bit, 44.1 kHz WAV file. Once you have recorded your final 
mix to the Auxiliary Stereo track in Capture 2, we recommend you export 
the audio from the Auxiliary Stereo track to an audio file for this purpose. 
See Section 7.6.2 for details on exporting audio tracks in Capture 2.

Once the correct audio file for your mix has been exported, you 
may use any CD-burning application (including PreSonus Studio 
One Professional) to put the mix on a recordable audio CD.

7.8.3	 Mixing a Capture 2 Session in Studio One

Many users want to use Capture 2 strictly as a track-recording tool and will 
mix and sweeten the recorded tracks later in a DAW. PreSonus has included a 
copy of Studio One Artist with your StudioLive for this purpose. All versions of 
Studio One can open Capture 2 Session files. All markers, edits, track names, 
etc., will be preserved. No further effort is required; simply launch Studio 
One and open your Capture 2 Session. See Section 8 for more details.

Power User Tip: StudioLive mix scenes are also compatible with Studio One 2.6 and later. 
Opening a Capture session in Studio One that has a StudioLive mix scene saved with it will 
load the StudioLive mix scene in the Studio One mixer. See Section 8.6 for more details.
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7.8.4	 Mixing a Capture 2 Session in a Different Recording Application

For users who wish to mix their Capture 2 Session in a DAW other than Studio 
One, there are several ways in which to import your Capture 2 Session.

Save a Capture 2 Session as OpenTL

Many audio-recording programs can open OpenTL (Open Track List) files. An OpenTL 
file provides a reference for all of the audio tracks and audio events, with their 
corresponding positions, in a Capture 2 Session, so that another audio program can 
reconstruct your Session automatically. This makes it possible for you to open your 
Capture 2 Session and work as you normally do in your favorite recording application.

To save an OpenTL version of your Session, select Save 
Session As in the File menu of Capture 2. 

Name the file as usual, and choose OpenTL (*.tl) in the Save As Type selection box. 

Click on Save to save your Session as an OpenTL document and confirm the 
command by clicking Yes in the confirmation window. This file will be placed 
by default in your Session folder and will not overwrite the original Capture 2 
Session file. Note that the OpenTL format will not save your markers.

Import Capture 2 Session Audio Files Directly

Some audio-editing applications (such as digital audio workstations, or DAWs) 
do not support the OpenTL format, which makes the options somewhat limited 
when importing Sessions created in other programs. In this case, you must 
manually import the audio events from your Capture 2 Session into the audio-
editing application, using whatever means possible in that program. Refer to 
the documentation of your software for more information on this process.

Note that in some cases, you may have more than one audio event on a given track, 
as opposed to a single continuous audio event, or you may have audio events that 
do not have the same start position. In either case, we highly recommend that you 
first export the audio for each track before attempting to import into an audio-
editing program, as described in the Export Audio Files portion of this section.

Be sure to select the Export Tracks option in the Export Audio 
File menu, as shown, so that the result of the process will be a 
single, continuous audio file for each track in the Session.

Once you have single, continuous audio files for each track, directly importing 
the files into an audio editor is much easier. All that is required to reconstruct 
your Capture 2 Session is to align each file at the same start time. For complete 
information on exporting tracks from Capture 2, please review Section 7.6.2.
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7.9	 Capture 2 Key Commands

Action Key Command

File Menu

New Session Cntrl/Cmd+N

Open Session Cntrl/Cmd+O

Close Session Cntrl/Cmd+W

Save Session Cntrl/Cmd+S

Save Session As Cntrl/Cmd+Shift+S

Save Mix Scene Cntrl/Cmd+H

Load Mix Scene Cntrl/Cmd+Shift+H

Quit Cntrl/Cmd+Q

Edit Menu

Undo Cntrl/Cmd+Z

Redo Cntrl/Cmd+Y

Cut Cntrl/Cmd+X

Copy Cntrl/Cmd+C

Paste Cntrl/Cmd+V

Delete Del

Select All Cntrl/Cmd+A

Deselect All Cntrl/Cmd+D

Bounce Selection Cntrl/Cmd+B

Zoom In Cntrl/Cmd + or E

Zoom Out Cntrl/Cmd - or W

Zoom Full F

Session Menu

Import File Command+I

Export Tracks Command+E

Toggle Start/Stop Space Bar

Record NumPad *

Stop 0

Return to Zero ,

Go to End E

Loop Active /

Loop Selection P

Locate Selection L

Insert Marker Ins, I

Insert Named Marker Shift+Ins, Shift+I

Locate Next Marker N

Locate Previous Marker B

Enable Sound Check F4

Tools

Select Arrow Tool 1

Select Range Tool 2

Select Split Tool 3

Select Eraser Tool 4

Views

Options Cntrl/Cmd+[+]

Big Meters F2

Marker List F3

Enable Soundcheck F4

Action Key Command

Transport

Toggle Start/Stop Space Bar

Start Enter

Record NumPad *

Stop NumPad 0

Return to Zero NumPad

Record Lock Cntrl/Cmd+L

Navigation

Focus Next Tab

Focus Previous Shift+Tab

Left Left Arrow

Extend Selection Left Shift+Left Arrow

Extend Selection Left Add Cntrl/Cmd+Shift+Left Arrow

Skip Left Cntrl/Cmd+Left Arrow

Right Right Arrow

Extend Selection Right Shift+Right Arrow

Extend Selection Right Add Cntrl/Cmd+Shift+Right Arrow

Skip Right Cntrl/Cmd+Right Arrow

Up Up Arrow

Extend Selection Up Shift+Up Arrow

Extend Selection Up Add Cntrl/Cmd+Shift+Up Arrow

Skip Up Cntrl/Cmd+Up Arrow

Down Down Arrow

Extend Selection Down Shift+Down Arrow

Extend Selection Down Add Cntrl/Cmd+Shift+Down Arrow

Skip Down Cntrl/Cmd+Down Arrow

Page Up Page Up

Extend Selection Page Up Shift+Page Up

Extend Selection Page Up Add Cntrl/Cmd+Shift+Page Up

Skip Page Up Cntrl/Cmd+Page Up

Page Down Page Down

Extend Selection Page Down Shift+Page Down

Extend Selection Page Down Add Cntrl/Cmd+Shift+Page Down

Skip Page Down Cntrl/Cmd+Page Down

Start Home

Extend Selection Start Shift+Home

Extend Selection Start Add Cntrl/Cmd+Shift+Home

Skip Start Cntrl/Cmd+Home

End End

Extend Selection End Shift+End

Extend Selection End Add Cntrl/Cmd+Shift+End

Skip End Cntrl/Cmd+End
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8	 Studio One Artist Quick Start
Your StudioLive AI mixer comes with Studio One Artist recording and production 
software. Whether you are about to record your first album or your fiftieth, 
Studio One Artist provides you with all of the tools necessary to record and 
mix a great performance. As a valued PreSonus customer, you are also eligible 
for a discount upgrade to Studio One Producer or Studio One Professional.

For more details on the Studio One upgrade program for 
PreSonus customers, please visit www.presonus.com.

8.1	 Installation and Authorization

Once you have installed the StudioLive drivers and connected your StudioLive 
to your computer, you can use the included PreSonus Studio One Artist music-
production software to begin recording, mixing, and producing music.

To install Studio One Artist, insert your installation disc into your computer’s DVD 
drive. Follow the onscreen instructions to complete the installation process.

8.1.1	 Running the Studio One Installer

To Install Studio One Artist, insert your Studio One Artist 
installation DVD into your computer’s DVD drive.

nus Audio E lect
-A

Windows Users: Launch the Studio One Artist installer 
and follow the onscreen instructions.

Mac Users: Drag the Studio One Artist application into 
the Applications folder on your hard drive.

8.1.2	 Creating a User Account

1.	 After installing Studio One Artist, launch the program, and the Activate Studio One 
menu will appear. 
 
 

2.	 Click on the Activate or Upgrade link to begin.

3.	 If you are a new Studio One user, you will need to create a user account. Click on 
the “Create New Account” link if your computer is connected to the Internet.
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If your computer is not connected to the Internet, skip to 
Section 8.1.4 “Activating Studio One Artist Offline.”

If you already have a PreSonus user account, you can skip to 
Section 8.1.3 “Activating Studio One Artist Online.”

4.	 Fill out the user registration form. You will be asked to create a username and 
password. This information will be used to access your PreSonus user account 
on the PreSonus Web site. With this account, you can manage the registrations 
for all of your PreSonus hardware and software products. You will be notified 
of, and will have access to, important information and updates related to your 
PreSonus products, ensuring you get the best performance possible from them.

Your username and password will also provide you with access to the PreSonus 
user forums to chat with other PreSonus users as well as PreSonus employees.

Power User Tip: Once your user account has been successfully created, you will be alerted 
that the activation email has been sent to the email address that you provided. Don’t 
forget to activate your PreSonus user account the next time you check your email!

8.1.3	 Activating Studio One Artist Online

Now that you have created a user account, you can 
activate your copy of Studio One Artist.

1.	 Click on the Activate Online link.

2.	 Your previously created account username and password 
will automatically be filled in. Enter the Studio One Product 
Key located on the Studio One Artist disc wallet.
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3.	 Click on the Activate button to finish the activation process. Please skip to Section 
8.1.5 for instructions on installing content. 

8.1.4	 Activating Studio One Artist Offline

1.	 Click on the Activate Offline Link.

2.	 Write down the Activation Code listed under Step 3 in the 
onscreen instructions. You will need this for Step 9.

Activation Code: ____________________________________

3.	 Visit my.presonus.com on an Internet-connected computer and click 
on the Create New Account to create your PreSonus user account. You 
can also login using your Google, Facebook, or LinkedIn profile.
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4.	 Fill out the PreSonus Registration form.

5.	 Once you have created your user account, log in and 
click on the Software Registration button.

6.	 Enter the Product Key located on the Studio One 
Artist disc wallet and click “Submit.”

7.	 Click on the Activate Software button.

8.	 Enter the Activation Code you wrote down in Step 2.
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9.	 Click on the Download License button.

10.	A file called “Studio One 2 Artist.license” will be saved onto your computer. You will 
need to copy this onto a piece of removable media and transfer it onto the 
computer on which you want to run Studio One Artist. 
 
 
 

11.	After installing Studio One Artist, launch the program, and the Activate Studio One 
menu will appear. 
 
 
 

12.	Click on the Activate or Upgrade link to begin.

13.	From the Activate Studio One Menu, click on the “Activate Offline” link.

14.	Drag the “Studio One 2 Artist.license” file onto the Offline 
Activation window to complete the activation.
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8.1.5	 Installing Bundled Content for Studio One Artist

The Studio One Artist bundle includes all that you need to begin 
producing music. This includes an array of demo and tutorial material, 
instruments, loops, samples, and other third-party content. 

Upon completing the Studio One Artist installation and activation 
process, the Studio One Content Installer will appear.

1.	 Click on “Install content from DVD or local folder.”

2.	 At the top of the installation menu, select the source from which the 
content will be installed, as well as the location where you wish to install 
the content. The source of the content will be the same DVD from which 
you installed Studio One Artist. By default, Studio One Artist will point 
to your DVD drive as the content source. Click on the Install Packets 
button at the bottom of the window to install the selected content.

3.	 If you would like to install the 3rd Party Content at this time, see the next 
section. If you are finished, click on the Done button to exit the menu.

Power User Tip: Studio One Artist content can be installed at any time by 
accessing the Studio One 2>Studio One Installation... menu. If you choose 
not to install any portion of the content, you can install it at a later time.
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8.1.6	 Installing Third-Party Content

To install any of the third-party content, click on the arrow button next to its name in 
the content list (Celemony Melodyne Trial and Native Instruments Komplete Player).

Notice that next to Native Instruments Komplete a serial number is listed. You 
will need this number to authorize the plug-in the first time you open it.

When you have finished installing content, click the Done button.

Please Note: If you have any difficulty registering either plug-in, 
please contact the plug-in’s manufacturer for assistance.

8.1.7	 Enabling the Audio Driver

Studio One Artist was designed with PreSonus interfaces in mind, so the 
StudioLive setup is quick and easy. When Studio One Artist is launched, by 
default you will be taken to the Start page. On this page, you will find document-
management and device-configuration controls, as well as a customizable 
artist profile, a news feed, and links to demos and tutorials from PreSonus. 
If you have an Internet connection on your computer, these links will be 
updated as new tutorials become available on the PreSonus Web site.

Complete information on all aspects of Studio One Artist is available in the 
Reference Manual PDF located on the Studio One Artist installation disc. The 
information in this tutorial covers only the basic aspects of Studio One Artist 
and is intended to get you set up and recording as quickly as possible.

Power User Tip: If your computer is connected to the internet, Studio One will 
automatically check for and install the latest updates. Because PreSonus is 
constantly improving Studio One, it is highly recommended that you verify 
that you’ve installed the latest version the first time you launch it.

Simply click on the “Check for Updates” link on the Start Page.

Start Page: Setup Area. Shows Active Audio Driver and Sample 
Rate and Provides Quick Links to Configure Audio and MIDI.

In the middle of the Start page, you will see the Setup area. Studio One 
Artist automatically scans your system for all available drivers and selects 
a driver. By default, it will choose a PreSonus driver, if one is available.
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Selecting a Different Audio Driver from the Start Page.

If you do not see “PreSonus FireStudio” on the Start page when you 
launch Studio One, click on the Configure Audio Devices link in 
the Setup area to open the Audio Setup Options window.

In the Audio Device menu, select “PreSonus FireStudio.”

Click the Apply button and then OK.

After you have verified that the PreSonus FireStudio driver has been detected 
(remember: StudioLive shares a driver with the PreSonus FireStudio family 
of interfaces), please continue to the next section to set up a new song.

8.2	 Creating a New Song

1.	 From the Start page, select “Create a new Song.”

2.	 In the browser window, name your Song and choose 
the directory in which you’d like it saved.

3.	 Select Empty Song from the Templates list. Note that you can select any one of 
the templates in the list to instantly create a pre-configured Session with tracks 
armed and ready for recording (similar to Capture). You can also create your own 
custom templates. Review the Studio One Reference Manual for more information.
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4.	 Make sure the Sample Rate matches the rate set on your StudioLive mixer. 
You can also determine the length of your Song and the type of time format 
you would like to use (Notation Bars, Seconds, Samples, or Frames).

5.	 If you plan on importing loops into your Song, you may want to select 
Stretch Audio Loops to Song Tempo so that any loop of a known BPM (like 
those in the included content library) will import at the correct tempo.

6.	 Click the OK button when you are finished. 

7.	 Go to Song>Song Setup menu.

8.	 Click on “Audio I/O Setup.”

9.	 We recommend that you create a mono input for each of the inputs 
on your StudioLive. If you plan on recording in stereo, you should also 
create a stereo bus and assign it to the appropriate set of inputs.

10.	You can remove any bus by simply selecting it and clicking the Remove button. 

11.	To customize the names of your buses, double-click on the default 
name to open a text box. When you have finished typing, hit Enter.
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12.	 If you would like the same inputs to be available every time you launch Studio One 
Artist, click the “Make Default” button.

13.	Click on the Outputs tab, and you will see all of the available 
outputs on your StudioLive. We recommend that you create a 
mono output for each of your StudioLive’s digital returns and a 
stereo output for the Main Digital Return on your StudioLive.

14.	Be sure to patch the Main Out bus to the Main Digital Return 
on your StudioLive (Returns 33-34, 25-26, 17-18).

15.	 In the lower right corner, you will see the Audition select menu. This allows you to 
choose the output from which you will audition audio files prior to importing them 
into Studio One Artist. In general, you will want this to be the main output bus.

16.	 If you would like this output configuration available every time you launch Studio 
One Artist, click the Make Default button.

17.	Click Apply to finish.

Now that you’ve configured your MIDI and audio I/O and created a new Song, let’s 
go through some of the basics of Studio One Artist so you can start recording!

8.3	 Creating Audio Tracks

In the upper left corner of the Arrange window, you will notice 
several buttons. The third button from the left is the Add Tracks 
button. Click this button to bring up the Add Tracks window.

In the Add Tracks window, you can select the number and type of tracks you’d like 
to create (Mono Audio, Stereo Audio, Folder, Instrument, or Automation) and can 
customize the track name and color as well as add a preset rack of effects to the track.
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Once you have added your tracks, you can assign the input by simply 
clicking on the input to which a track is currently assigned. This will bring 
up the inputs list. You can also access the audio I/O setup from here.

If you would like to add a track for each of the available inputs and have the 
routing automatically assigned, simply go to Track | Add Tracks for All Inputs.

8.3.1	 Anatomy of an Audio Track

Track
Name

Audio Input
Select

Meter

LevelSoloMute

Rec Arm

ST/Mono

Monitor
(in S1)

Track Color
Select
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8.4	 Adding Virtual Instruments and Plug-in Effects to Your Song

You can add plug-ins and instruments to your Song by dragging-and-dropping 
from the browser. You can also drag an effect or group of effects from one 
channel to another, drag in customized effects chains, and instantly load your 
favorite virtual-instrument patch without ever scrolling through a menu.

Opening the Browser, Editor, and Mixer

In the lower right corner of the Arrange window are three buttons.

The Edit button opens or closes the audio editor or the MIDI piano-
roll editor, depending on which type of track is selected.

The Mix button opens and closes the mixer window.

The Browse button opens the browser window, which displays all of the 
available virtual instruments, plug-in effects, audio files, and MIDI files, 
as well as the pool of audio files loaded into the current session.

At the bottom of the browser window, you will find six category tabs:

•• Home opens hot links to the other five tabs.

•• Instruments opens a list of all the available Virtual Instruments 
that you have installed on your computer.

•• Effects opens a list of all the available plug-in effects 
that you have installed on you computer.

•• Sounds opens a list of the audio and MIDI loops that 
came with your Studio One content packages.

•• Files provides you with quick access to every file on your computer.

•• Pool opens a list of the audio files that have been recorded 
and imported into your current session.

8.4.1	 Drag-and-Drop Virtual Instruments

To add a virtual instrument to your session, click the Browse and Instrument 
buttons to open the instrument browser. Select the instrument or one 
of its patches from the instrument browser and drag it into the Arrange 
view. Studio One Artist will automatically create a new track and load the 
instrument as the input. For more information on Instrument and MIDI 
configuration, please review the Studio One Reference Manual.
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8.4.2	 Drag-and-Drop Effects

To add a plug-in effect to a track, click the Effects button and select 
the plug-in or one of its presets in the effects browser, then drag the 
selection over the track to which you would like to add the effect.

8.4.3	 Drag-and-Drop Audio and MIDI Files

Audio and MIDI files can be quickly located, auditioned, and imported into 
your Song by dragging them from the file browser into the Arrange view. 
If you drag the file to an empty space, a new track will be created with that 
file placed at the position to which you dragged it. If you drag the file to 
an existing track, the file will be placed as a new part on the track.

8.5	 Recording in Studio One Artist

Now that you’ve gone through the basics of configuring 
and using Studio One Artist, let’s record a track!

1.	 To begin recording, create a mono audio track.

2.	 Select Input 1 as the input source.

3.	 Connect a microphone to the channel 1 input on the StudioLive.
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4.	 Select Record Enable on your track in Studio One Artist.

5.	 Turn up the Channel 1 level while speaking/singing into the microphone. 
You should see the input meter in Studio One Artist react to the input.

6.	 Adjust the gain so the input level is near its maximum without clipping (distorting).

7.	 Connect a set of headphones to the StudioLive headphone output

8.	 If you wish to listen to your StudioLive with studio monitors, make sure to connect 
them to the StudioLive’s Control Room outputs. 
 
 
 
 
 
 
 
 

studio monitors
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9.	 Enable the Main bus in the monitor bus on your StudioLive so you can monitor 
through headphones or using the Control Room Outs on your StudioLive and your 
studio monitors. 
 
 
 
 
 

In Studio One, click Record.

10.	Sing or speak into the microphone. 
 
 
 
 
 
 
 

11.	When you are done, click the Stop button in Studio One 
or press the Space bar to stop the recording.

12.	On the StudioLive, engage the Main Digital Return button in the Monitor Bus.

13.	Click the Return to Zero button in Studio One or press the 
“,” key to return to the beginning of the Song.

14.	Click Play in Studio One, or press the Space bar to listen to your recording.

For complete instructions, please consult the Studio One Reference 
Manual, which is located on your Studio One Artist installation DVD.



8	 Studio One Artist Quick Start 
8.6	 Mixing Capture Sessions in Studio One Artist

StudioLive™ AI Software Library 
Reference Manual

113

8.6	 Mixing Capture Sessions in Studio One Artist

Capture and Studio One were designed to work with one another, 
as well with as the StudioLive AI mixers and the rest of the software 
applications in the StudioLive AI Software Library. 

Built into Studio One 2.6 and later is a Native Effects™ plug-in version of the 
StudioLive AI Fat Channel. This plug-in provides exact versions of the signal 
processors in the StudioLive 32.4.2AI and 24.4.2AI Fat Channel. This is a 
regular Studio One Native Effects plug-in and works even if your StudioLive 
AI mixer is not connected to your computer. All parameters that are variable 
in the StudioLive 32.4.2AI / 24.4.2AI Fat Channel are also variable in the 
Fat Channel plug-in for the StudioLive 16.4.2AI, even if the parameters are 
fixed in the StudioLive 16.4.2AI hardware (e.g., limiter Threshold).

Power User Tip: Studio One Fat Channel plug-in presets are fully compatible with 
your VSL-AI Fat Channel preset files. Any presets saved to your computer from 
VSL-AI will automatically load in Studio One on launch and be available for use.

Fat Channel plug-in presets created in Studio One can exported to VSL-AI 
by selecting Export Channel Preset from the plug-in header menu. These 
presets can then be loaded onto your StudioLive mixer from VSL-AI. 
 
 
 
 
 
 
 

Launching Capture Sessions

As previously mentioned, Capture Sessions are fully 
compatible with Studio One Artist. Simply open your 
Capture Session in Studio One, just as you would a 
Studio One session. 
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If your Capture Session has a StudioLive AI mix scene saved with it, your Studio 
One mixer will load the scene, complete with all your Fat Channel settings, 
fader levels, FX sends, mutes, solos, pan settings, and bus assignments. This 
allows you to mix your Capture sessions with the same Fat Channel settings 
you used live, even when you’re away from your StudioLive AI mixer.

Studio One will create four FX buses and preserve any channel 
sends to them; however you will need to drag and drop your 
favorite reverb and delay plug-ins on these buses as there are no 
Native versions of the StudioLive reverb and delay engines.

For linked channels, Studio One will also load the Binaural Pan plugin to maintain 
the width control provided by your StudioLive AI-series mixer for stereo channels.
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	 Dinner is Served

Added bonus: PreSonus’ previously Top Secret recipe for…

Redfish Couvillion
Ingredients:
•• ¼ C Vegetable oil
•• ¼ C flour
•• 1 onion diced
•• 1 clove garlic minced
•• 1 green pepper diced
•• 3 celery stalks diced
•• 1 14oz can diced tomatoes
•• 1 bottle light beer 
•• 2 bay leaves
•• 1 tsp thyme
•• 2 lbs Redfish fillets

Cooking Instructions:
1.	 In a heavy saucepan or large skillet, heat oil on medium high and slowly add flour a tablespoon at a time to create a roux. 

Continue cooking the roux until it begins to brown, creating a dark blond roux. 
2.	 Add garlic, onions, green pepper, and celery to roux.
3.	 Sauté vegetables for 3-5 minutes until they start to soften.
4.	 Add tomatoes, bay leaves, thyme, and redfish. Cook for several minutes.
5.	 Slowly add beer and bring to a low boil.
6.	 Reduce heat and simmer uncovered for 30-45 minutes until redfish and vegetables are completely cooked, stirring 

occasionally. Break up redfish into bite size chunks and stir in. Add pepper or hot sauce to taste. Do not cover.
7.	 Serve over rice

Serves 6-8
While not one of Southeast Louisiana’s more famous dishes, Redfish Couvillion is a favorite way to serve our 
favorite Gulf fish. Also known as Reds or Red Drum, Redfish is not only fun to catch, it’s also delicious!
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